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Gendex® Dental Systems reserves the right to make changes to both 
this Operators’ Manual and to the products it describes. Equipment 
specifications are subject to change without notice. Nothing 
contained within this manual is intended as any offer, warranty, 
promise or contractual condition, and must not be taken as such.

This document may not, in whole or in Part, be copied, photocopied, 
reproduced, translated, or reduced to any electronic medium or 
machine-readable form without prior consent in writing from 
Gendex®, 901 West Oakton Street, Des Plaines, IL 60018 USA.

Gendex® is a registered trademark, other names may be trademarks 
of their respective owners.

For more information or an original version of documentation on the 
this Imaging System, by Gendex®, please write, to Gendex® at the 
above address or Fax to 1-847-550-1322. This documentation has 
been drafted, approved & supplied in the English Language. 
Imaging Sciences International will make available under request 
any component parts, calibration instruments, circuit diagrams, etc.

No part of this document may be reproduced or transmitted in any 
form or by any means, electronic or mechanical, for any purpose, 
without prior written permission of Gendex®. The information in 
this document and the product it describes are subject to change 
without notice. Names and data used in examples herein are 
fictitious unless otherwise noted. The software program described in 
this document is provided to its users pursuant to a license or 
nondisclosure agreement. Such software program may only be used, 
copied, or reproduced pursuant to the terms of such agreement. This 
manual does not contain or represent any commitment of any kind 
on the part of Gendex® Dental Systems.
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Chapter

 1 Introduction

System Description

The system is a Cone Beam Volumetric Tomography and 
Panoramic X-ray device used for dental applications. The system 
consists of a Scanner and Computer Workstation which is suitable 
for an in-office environment.

This scanning device is an open design that allows Patients to sit 
upright during a procedure. An electric powered seat is built into the 
device for proper Patient positioning.

GXCB-500™  Imaging System

PATIENT 
ALIGNMENT 

PANEL (ADJUSTS 
CHAIR UP/DOWN)

HEAD SUPPORT 
BACK PLATE 

KNOB
(SLIDES TO 

ADJUST THE 
POSITION OF THE 
HEAD SUPPORT)

MOTORIZED 
CHAIR

(MOVES
UP/DOWN VIA 
BUTTONS ON
THE PATIENT 
ALIGNMENT 

PANEL)

HEAD 
SUPPORT 

BACKPLATE

CHIN 
SUPPORT

GATE
(SWINGS OPEN, 
MAGNETS LOCK 

IN PLACE)
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The system consists of a Scanner and Computer Workstation. In 
order for the system to operate, both the Scanner and Computer 
Workstation must be turned ON.

The system captures data for 3D Skull Reconstruction for the 
following procedures:

• Implants

• TM Joints

• Reconstructed Panoramic

• Reconstructed Cephalometrics

• Airway / Sinus, etc.

• Nerve Canal

• PAN - Conventional Digital Panoramic Feature

Cone Beam Volumetric Tomography is a medical imaging 
technique that uses X-rays to obtain cross-sectional images. Quality 
of the images depends on the level and amount of X-ray energy 
delivered to the tissue. Imaging displays both high-density tissue, 
such as bone, and soft tissue. When interpreted by a trained 
Physician, these images provide useful diagnostic information.

Major System Items
The system is comprised of the following major items:

• Scanner
• Computer Workstation
• Operator Control Box with 50 ft. (15.2m) Cable
• Patient Emergency Stop Box with 10 ft. (3m) Cable
• Interlock Jumper Cable, 8 inch (20cm)
• Interlock Cable 50 ft. (15.2m)
• Warning Light Cable 50 ft. (15.2m)
• Chair Connection Cable, 10 ft. (3m)
• Power Cable, 15 ft.(4.6m)
• CAT 5 Ethernet Cable, 50 ft. (15.2m)
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About the Operators’ Manual

This documentation describes the safe and effective operation of the 
system. The information is intended to provide trained 
Technologists and Physicians the necessary guidance to operate the 
system in a safe and effective manner.

Conventions Used in the User Manual

• Keyboard keys are represented in a Bold font. 

For example, “Press Start.”

• Menu items and button names on the user interface display 
are represented in a Bold font.

For example, “At the Print window, click the Print button.”

• Keyboard entries are represented in bold Courier font.

For example, “Type QA Test in the filename box.”
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Standard Limited Warranty

Gendex warrants the original purchaser that this hardware system 
will be free from damage for a period of one (1) year from the date 
of delivery. During the warranty period, Gendex will correct any 
defects in material or workmanship, at no charge for materials. Any 
replacement parts shall be new or serviceable used parts and are 
warranted for the remainder of the original warranty or thirty (30) 
days, whichever is longer. The warranty period is not extended as a 
result of purchasing any additional parts from Gendex. The original 
purchaser must promptly notify Gendex in writing if there is a defect 
in material or workmanship. Written notice in all events must be 
received by Gendex before expiration of the warranty period. This 
warranty is not transferable. 

This One-Year Limited Warranty covers normal use. Gendex does 
not warrant or cover:

• Damage caused by impact with other objects, dropping, 
falls, spilled liquids or immersion in liquids

• Damage caused by a disaster such as fire, flood, wind, 
earthquake, or lightning

• Damage caused by unauthorized attachments, alterations, 
modifications or foreign objects

• Damage caused by peripherals

• Damage caused by failure to provide a suitable environment

• Damage caused by the use of the hardware system for 
purposes other than those for which it was designed

• Damage from improper maintenance

• Damage from improper electrical connection or supply

• Damage caused by any other abuse, misuse, mishandling, or 
misapplication

• Damage to acquisition computer, software, or operating 
system caused by

o Additions or changes unauthorized by Gendex
o Viruses, spyware, or gaming software
o Damage caused by Network or Operating Engineers
o Damage from the use of this machine or computer 

for any other purpose
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o Applications other than its intended use
o Damage caused by third party software
o Damage caused by unauthorized changes to the 

system software
o Damage caused by unauthorized upgrades, additions 

or deletions
o Damage caused by internet use, or any other 

unauthorized application.
 
Under no circumstances shall Gendex be liable for any special, 
incidental, or consequential damages based upon breach of 
warranty, breach of contract, negligence, strict liability or any other 
legal theory. Such damages include, but are not limited to, loss of 
data, loss of profits, loss of revenue, loss of use of hardware system 
or any associated equipment, cost of capital, cost of substitute or 
replacement equipment, facilities or services, down time, 
purchaser's time, the claims of third party, including customers, and 
injury to property.

Disclaimer of Warranties
The warranty stated above is the only warranty applicable to this product, 
all other warranties, expressed or implied including all implied warranties 
of merchantability or fitness for a particular purpose, are hereby dis-
claimed. No oral or written information or advice given by Gendex, its 
agents or employees shall create a warranty or in any way increase the 
scope of this warranty
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Chapter

 2 Safety Items

Important Safety Information
Gendex designs its products to meet stringent safety standards. 
However, to maintain the safety of Operators and Patients, you must 
operate the equipment correctly and properly and ensure the 
equipment is properly maintained.

It is essential to follow all safety instructions, warnings, and cautions 
specified in this manual to ensure the safety of Patients and 
Operators. In addition, read and observe all danger and safety 
labelling on the system.

Before attempting to use the equipment for any patient examination, 
read, understand, and know how to implement the Emergency Stops 
on the system.

Warnings, Cautions, and Notes
Before attempting to operate the equipment, it is recommended that 
you read this manual thoroughly including all cautions and 
warnings. This guide uses the following conventions to describe 
situations that are potential hazards to the Patient or Operator, 
potential loss of data, or potential damage to the equipment.

WARNING
Warnings are intended to alert the user that failure to follow the 
procedure could cause fatal or serious injury to the user, Patient, or 
any other person, or result in a misdiagnosis.

CAUTIONCAUTION
Cautions are intended to alert the user that failure to follow the 
procedure could cause damage to the equipment or cause loss of 
data.
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ADVISORY: Advisories are used to defined information for the 
operator regarding advice towards use of the device or a process.

NOTE: Notes are used to highlight important or unusual points to be 
brought to the attention of the operator.

Safety Precautions

WARNINGWARNING
The X-ray device may be dangerous to the Patient and Operator if 
you do not observe and follow the operating instructions. Do not 
operate this system unless you have received training to perform a 
procedure.

WARNINGWARNING
Do not remove covers or cables on system. High voltage is present 
in the system. To avoid personal injury from electrical shock, do not 
operate the system with any covers open or cables removed.

WARNING
Closing the Gate creates a pinch point. Keep hands and other body 
parts clear when closing Gate.

Electrical Hazards

Installation and system wiring must meet all requirements of local 
governing authorities. Please check your local authorities and local 
codes to determine best practices for a safe installation.

Do not place any liquid or food on any part of the consoles or other 
modules of the system.

Observe all fire regulations. Fire extinguishers should be provided 
for both electrical and non-electrical fires. All operators should be 
fully trained in the use of fire extinguishers and other fire-fighting 
equipment and in local fire procedures.
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WARNINGWARNING
In the event of an electrical fire, only use extinguishers that are 
labelled for that purpose. Using water or other liquids on an 
electrical fire can lead to fatal or other serious personal injury.

WARNINGWARNING
In the event of an electrical fire, to reduce the risk of electrical shock, 
try to isolate the equipment from the electric source before 
attempting to extinguish the fire.

Explosion Hazard

Do not use the System in the presence of explosive gases or vapors, 
including anaesthetic gases. Use of this system in an environment 
for which it is not designed can lead to fire or explosion.

WARNING
This unit is not suitable for use in a flammable air mixture 
environment.

If hazardous substances are detected while the system is turned on, 
do not attempt to turn off the system. Evacuate the area and then 
remove the hazards before turning off the system.

Mechanical Hazards

WARNING
Do not operate the system with any covers open or removed. 
Operating the system with open or removed covers could expose 
mechanical operating systems that could cause serious or fatal 
personal injury to you or the Patient. Only qualified and authorized 
service personnel should remove covers from the system.

Carefully observe the patient during the scanning procedure to 
ensure that when the System Gantry moves, the patient does not 
collide with the Gantry or other equipment. Ensure that the patient 
does not grab or hold any part of the system or nearby equipment.



2-4

Gendex GXCB-500TM Service Manual

G990710    30 June 2008

Collision System

The Gantry motor is programmed to operate at a rotational force of 
< = 15 lbf (66.7N). Interference or incidental contact with the Gantry 
during rotation, which results in an interruption in Gantry motion, 
will be detected and trigger a system stall event. This will result in a 
system fault condition which will cause the following system events 
to occur:

• Stepper Motor power is removed

• X-Ray operations cease

• System Fault Light illuminates

• X-Ray Audio and Visual indicators de-energize

Operator intervention is required to recover the system for normal 
use.

Laser Beam Hazards

WARNING
Laser beams can cause optical damage. Close eyes when the laser 
beam is in use. Instruct the Patient to close eyes to avoid looking into 
the beam. The use of optical instruments such as eyeglasses with 
large diopter or mirrors, increase eye hazard with this product.

The System Gantry has laser markers to assist you in planning scan 
procedures. If you are using the laser markers while a patient is in 
the chair, warn the patient that the laser beam could be harmful. 
Advise the patient that laser beams can cause optical damage. 
Instruct the patient not to stare at the laser beam and to avoid looking 
into the beam.
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Radiation Safety

X-rays are dangerous to both operator and others in the vicinity 
unless established safe exposure procedures are strictly observed. 
Use the following safety measures to ensure safety to the Patient and 
Operator.

The useful and scattered beams can produce serious or fatal bodily 
injuries to Patients and persons in the surrounding area if used by an 
unskilled operator. Adequate precautions must always be taken to 
avoid or reduce exposure to the useful beam or to scattered radiation.

Operators are strongly urged to comply with the current 
recommendations of the International Commission on Radiological 
Protection and, in the United States, the US National Council for 
Radiological Protection.

Radiation Protection Measures

Use the following measures to protect yourself and the patient from 
unintended exposure to radiation. Anyone who is near the patient 
during test procedures must observe the following precautions:

• Maintain adequate distance from exposed radiation source.

• Keep exposure times to a minimum.

• Wear protective clothing (lead apron, etc.) to protect the 
anatomical areas.

• Wear a PEN dosimeter and/or film badge.

• If you are required in the exam room during a procedure, 
stay as far from the scanner as possible or behind a mobile 
protective wall.

• The physician is responsible for protecting the patient from 
unnecessary radiation.
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System Safety Devices

Emergency Stops

This manual contains instructions for safe operation of this dental X-
ray System. In the event of an emergency (any moving component 
collides with any parts of the equipment or items in the environment, 
or that could cause physical injury to the Patient), the Operator and/
or Patient should utilize the Emergency Stop buttons to turn off the 
power to all moving parts in order for the Patient to be safely 
removed from the machine.

Warning System

The System is equipped with provisions for warning lights and/or 
audible alarms when X-ray power is energized.

An externally powered Warning System can be connected to the 
cable provided which is capable of 250 volts, 50/60 hertz, and 2.5 
amps. When X-ray power is energized the warning system is also 
energized.

Interlock System

This System is equipped with provisions for an Interlock Circuit 
which, when opened, will turn off X-ray power. This is a low voltage 
circuit, 12 volts DC. To use the Interlock Circuit disconnect the 
factory installed Shorting Plug. Connect the supplied Interlock 
Cable to the scanner. Connect door switches (NO/COM terminals) 
and/or emergency stop switches (NC/COM terminals) in series 
between the other end of the Interlock Cable wires.

Multiple door switches and/or emergency stop switches can be 
connected as long as the devices are connected in series. The entire 
circuit must be a closed loop when all of the doors are closed and/or 
emergency stop switches are in their normally closed state. 
Whenever the door switch or switches are opened or emergency stop 
button(s) pressed the X-ray power will be turned off. X-ray power 
cannot be turned on when the interlock circuit is open.
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Sample Site Plan

Below are two typical scanning room layouts that illustrate the 
system interconnect for the Warning System, Operator Control Box 
(Emergency Stop) and Interlock System which are all describe 
above. Room layouts must provide a means for audio and visual 
communication between the Operator and Patient. The Patient 
Emergency Stop Box, which can stop the operation of the X-ray 
device, must be within reach of the Patient when scanning occurs.

Scanner

Computer
Workstation

Operator Control Box 
with 50 ft. (15.2m) Cable

Patient
Emergency Stop

Box with
10 ft. [3m] Cable

Interlock Cable
50 ft. [15.2m]

(if used)

Warning System
Cable

50 ft. [15.2m]
(if used)

CAT 5
Ethernet Cable 
50 ft. (15.2m)

Hallway

Warning
Light or Alarm
(not supplied)

Room Size
6.5 x 8.5 feet [2 x 2.6 meters]

Interlock Switches 
are not supplied

Window
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Interlock and Warning System Schematic

Scanner

Computer
Workstation

Operator Control Box 
with 50 ft. (15.2m) Cable

Patient
Emergency Stop

Box with
10 ft. [3m] Cable

Interlock Cable
50 ft. [15.2m]

(if used)

Warning System 
Cable

50 ft. [15.2m]
(if used)

CAT 5
Ethernet Cable 
50 ft. (15.2m)

Hallway

Room Size
8.5 x 8.5 feet [2.6 x 2.6 meters]

Warning
Light or Alarm
(not supplied)

Interlock Switches 
are not supplied

Customer
Connection

Back Panel System Board

Interlock
System

Warning
SystemNeutral

Return

Max. VAC 250V
Max. VDC 32 V
Max. Amps 1.5

Door Switch
Rating 12VD
100mA

Ground
Lamp

Ground Fuses

HIGH =
Door Close
Switch Close
OK to X-ray

HIGH
(X-ray ON)

Interlock
System

Warning System

Black

Red
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Cabling Requirements

System cabling connections must be installed away from walkways 
and doorways. It is recommended to run cabling along wall 
perimeters. If there is a chance of mechanical damage due to the 
cable location, then the use of conduit or other means of protection 
should be considered.

Emergency Removal of a Patient

If an emergency arises where it becomes necessary to interrupt a 
scan and/or remove a patient from the Patient Chair, use the 
following procedures.

1. Press an Emergency Stop button.

2. When you have determined that you can safely remove the 
patient, grasp and pull the gate outward.

3. Make sure the patient’s head will not touch the top of the Gantry 
and help the patient off the Patient Chair.
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System Labels

The following labels are attached to the system.

 Caution

Location: Multiple locations to indicate the 
operator should exercise caution when working 
near this area and should consult written 
instructions.

 Warning

Location: Rear of Overhead to indicate Electrical 
Hazard, Authorized Personnel only.

 IEC Label

Location: Rear of Overhead 
Type B: Protection against electrical shock (IEC 
60601.1 - 1990/A2 - 1995).

 Non-Ionizing Radiation Label

Location: Rear of Overhead

 Recycle Label

Location: Rear of Overhead 
Dispose of in accordance with your country’s 
requirements. 
This label indicates that there is material in the 
system that you must separately collect and 
recycle in accordance with the requirements of 
the European Waste Electrical and Electronic 
Equipment (WEEE) Directive.

Electric Power Off 

Location: Power Switch at rear of Overhead.

 Electric Power On

Location: Power Switch at rear of Overhead.
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 Caution: Laser Radiation 
Do not stare into beam

Location: Front center of Gantry and Source 
Panel.

 Caution: Laser Radiation 
Do not stare into visible light beam

Location: Alignment Panel.

 Caution: This X-ray unit may be dangerous to 
patient and operator unless safe exposure 
factors and operating procedure are observed. 
Unauthorized use is prohibited.

Location: Control Box

 Warning: Pinch point keep hands clear

Location: Inside of Patient Gate.
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 Caution: Maximum lifting capacity

Location: Patient Chair, below rear seat pad.

 Caution: Maximum lifting capacity

Location: Patient Chair, above rear seat pad.

 Chair Instruction Label 
Insert seat fully to line

Location: Patient Chair, behind seat pad.

 ETL / CE 0413 Label

Location: Inside of left leg assembly.

Scanner Model and Serial Number Label

Location: Rear of Overhead.

Tube Head Model and Serial Number Label

Location: Tube Head Assembly.
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Error Messages

The following are error messages that the system may display. If 
problems persist after performing the indicated action or actions in 
the message, call Service.
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 3 System Controls and 
Indicators

Controls and Indicators are found on the following system units:

• Operator Control Box

• Patient Alignment Panel

• Patient Emergency Stop Control

• System Status Indicators

Operator Control Box

ON powers the Scanner and 
the POWER indicator lights to 
show that the device is ON.

OFF removes power from the 
device and the POWER 
indicators go OFF.

EMERGENCY STOP 
immediately halts all X-ray 
and scanning activities.

SCAN initiates Patient X-ray 
scanning. (This allows the 
Operator Control Box to be 
mounted in a location different 
from the Computer 
Workstation.) When scanning 
is occurring, the 
X-RAY ON indicator is lit.

FAULT indicator lights when 
a system error occurs (such as an  
X-ray exposure problem).
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Patient Emergency Stop Control
PATIENT EMERGENCY STOP allows the 
Patient to halt all X-ray and scanning activities by 
pressing the button.

The Emergency Stop Control can either be hung 
from the head support mechanism or held in the 
Patient’s hand as desired.

Patient Alignment Panel 
WARNING
Laser beams can cause optical damage. Do not stare into the laser 
beam. Instruct the Patient to avoid looking into the beam. The use of 
optical instruments such as eyeglasses with large diopter or mirrors, 
increase eye hazard with this product.

ALIGNMENT LIGHT - pressing the button turns ON 
the laser alignment lights for two minutes, or until the 
button is toggled OFF. 

PATIENT ALIGN allows the Operator to move the 
Patient seat up and down to facilitate Patient alignment 
with the Chin Rest.

System Status Indicators
The System Status Indicators are located on both the 
overhead unit and the Operator Control Box.

POWER indicator is lit when the scanner is ON.

READY indicator is lit when the software Acquire 
button is pressed to begin the scanning process.

X-RAY ON indicator is lit during the scanning process.

FAULT indicator lights when a system error occurs 
(such as an x-ray exposure problem).
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 4 System Startup and 
Shutdown

It is recommended to do a System Shutdown each day at the close of 
business. The system is available for use immediately after System 
Startup,  no device warmup is required.

System Startup
The System includes the Scanner and a Computer Workstation. Both 
units must be ON to function properly. To start the system, do the 
following:

1. Power up the Scanner: press the ON button on the 
Main Control Box. The POWER indicator on the 
Main Control Box and Scanner light.

2. Power up Computer Workstation: press the 
power button on the front of the Workstation. The 
computer boots and loads the operating system. 

3. Launch Vision Software: double-click the Vision 
icon on Workstation desktop. The Vision software 
application is launched.

NOTE: Although the system is now ready to scan, the 
Ready indicator does not illuminate until the Acquire 
button is pressed to start a scan.

System Shutdown

The Scanner and Computer Workstation are powered independently. 
Both units are powered OFF as described below.

To shut down the system:
1. From the Main menu on the Computer Workstation, select  

File > Exit. Vision closes but the Windows desktop remains ON. 
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If changes were made to a case study, the following dialog box 
appears.

a. Click Yes. The dialog box closes.

b. Click Create New Workup.

c. Enter a name for new Workup in the Workup Name: field. 
Click OK 
or 
Overwrite an existing Workup by clicking an existing 
Workup Name.

2. Power OFF Scanner: press the OFF button on the Main 
Control Box. The Scanner shuts down and the POWER 
indicators on the Main Control Box and Scanner go OFF.

3. Power OFF Computer Workstation: from the 
Windows desktop, select Start > Shut Down and 
then select Shut Down and press OK. The 
Computer shuts down and the POWER indicator 
on the Workstation goes OFF.
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 5 System Assembly

Initial Preparation

Before beginning system assembly, please review the Safety chapter 
to familiarize yourself with the safety precautions related to the 
system.

Required Tools

Spirit Level

Tool Kit (supplied with unit)

• 3/16 inch T-Handle Allen Wrench

• 1/4 inch Nut Driver

• 5/16 inch Nut Driver

• 1/2 inch and 7/16 inch Open-end Wrench

• 1/16 - 5/16 Allen Wrench Set

Abbreviations

Hardware abbreviations used in this chapter:

• SHCS - Socket Head Cap Screw

• SS - Set Screw

• LW - Lock washer

• FW - Flat Washer
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Inventory of Unit Items

The following system items are included in the shipping crate. 

1. Gantry

2. Rear Scatter Shield 

3. Chair Assembly

4. Wall Mount Assembly

5. Tube Head Assembly Box

• Tube Head Assembly

6. Receptor Assembly Box

• Receptor Assembly

7. PC Monitor Box

• Monitor

• Power Cable

• VGA Cable

• DVI Cable

8. PC Box

• Cobra Software Key

• PC

• PC Power Cable

• Keyboard

• Mouse

• Power Strip

9. Accessories Box

• Documents

i 17-19 Operators’ Manual

i FDA Form 2579

i Certificate of Regulatory Compliance

• Cables

i Control Box Assembly with Cable

i Chair Extension Cable
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i Interlock Cable

i Warning System Cable

i CAT -5 Ethernet Cable

i Hospital Grade Power Cable

i Patient E-Stop with Holster

• Phantoms

i Cylinder Phantom

i Line Pair Phantom

i i-PAN Phantom

i Water Phantom Assembly

• Miscellaneous Accessories

i Calibration platform

i Head Rest Kit

i Chin Rest

i Chin Cups (2)

i Bite Tip Holders (2)

i Bite Tips (25)

i Booster Seat

i Foot Stool

i Chair Center Locator

i Glides (4)

i Tool Kit
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System Assembly
There are two methods used for shipping the device; assembled and 
non-assembled. Start with step one for the non-assembled scanner. 
Start with step 9 for scanners that are shipped assembled.

Before moving the System into place, ensure that the area is clean 
and that there is ample room to work.

WARNING
This system has devices that require a two person lift. Failure to 
comply may cause bodily injury. Two adults are required to unpack 
and assemble this system.

1.

1

With the help of an assistant, 
install the Lower Plate under the 
two Leg Assemblies, as shown.

2.

2 3/16

Attach with mounting hardware, 
four SHCS 1/4-20 x 5/5 long with 
1/4” Split Washers, both sides.
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3.

3
3/32

Remove top cover 
(six mounting screws).

WARNING
This devices requires a two person lift. Failure to comply may cause 
bodily injury. Two adults are required to assemble this device.

CAUTIONCAUTION
Use extreme care not to scratch Overhead Assembly when 
mounting unit onto Leg Assemblies.

4.

4

With an assistant, lift overhead 
device into place on top of Leg 
Assemblies.
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5.

5

Ensure the pins on rear of the 
Overhead device are seated into 
the holes on Leg Assemblies.

6.

6

When seated properly, 
Overhead device locks into 
place. To ensure safety, the 
Overhead should still be 
supported by an assistant until 
mounted.

7.

3/16

7

From rear of unit, secure 
Overhead with mounting 
hardware, two SHCS 
1/4-20 x 5/8 long with 1/4” 
Split Washers, both sides.
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8.

3/16
8

From top of unit, secure 
Overhead with mounting 
hardware, two SHCS 
1/4-20 x 5/8 long with 1/4” 
Split Washers, both sides.

CAUTIONCAUTION
Care must be taken when sliding the device into place. To prevent 
the unit from scratching the floor surface, place the four Glides 
under the device feet.

9.

9
10

With the help of an assistant, tilt the 
scanner to install the Glides under 
the four feet (corners of device).

10. Slide the scanner into place and 
remove the Glides.

11.

12
3/16

11

Position Patient Chair on 
device base. Ensure Base 
Frame Centering Screw is 
seated within Patient Chair 
Centering Block.

12. Loosely secure Patient 
Chair to Gantry (2 SHCS 
with lock washer). Do not 
tighten.
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WARNING
The Receptor Assembly requires a two person lift. Failure to comply 
may cause bodily injury.

13.

3/32

3/32

14

14
Locate Receptor Assembly and 
remove packing material.

14. Remove assembly cover from unit 
(4 outer screws).

15.
3/1617 16

With an assistant, mount the 
Receptor Assembly by aligning 
the mounting pins.

16. Attach assembly with four long 
mounting screws and four split 
washers, acquire four mounting 
screws from Red Shipping Plate.

17. Feed cabling through Receptor 
Assembly (8 wires).
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CAUTIONCAUTION
When mating connectors, do not force-fit connectors together.

18.
2119 20

All connectors are 
color coded and keyed 
to prevent improper 
mating.

19. Connect together the 
red/white connectors 
(grey wires) as shown.

20. Rotate into position, 
aligning red dots, then 
press to lock the gold 
connector (grey wire) 
onto the keyed Power 
connector.

21. Connect green wire 
RJ45 plug to LAN 
receptacle as shown.

22.

2422 23

Connect silver 
connector (grey wire) to 
assembly as shown. 
Access connector 
mounting screws by 
pulling back bottom of 
receptor cover (opposite 
side).

23. Rotate silver cylindrical 
connector (grey wire) into 
position, aligning red dots, 
then press to lock onto 
keyed connector as shown.

24. Attach ground lug by 
removing mounting nut 
and installing lug over the 
star-lock washer. Replace 
mounting nut.
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25.
25

Connect green connector 
(grey wire) to assembly as 
shown).

26.

26

27

Do not connect small white 
connector (grey wire). To 
be used for future use.

27. Dress cables using flexible 
plastic wire wrap.

28.

29 3/32

28

Install Receptor cover.

29. Attach mounting screws on 
top and bottom of cover.
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30.

3/16 30

Remove red Shipping 
Plate. Do NOT discard 
mounting hardware 
(quantity 8) or Shipping 
Plate.

Long screws used for 
Receptor Assembly 
mounting and short screws 
for Source Assembly.

31.

3/32

32

33

Locate X-ray Source 
Assembly and remove 
from packing material.

32. Place assembly on clean 
surface. Remove and set 
aside the magnetic 
mounted X-Ray Source 
window panel from the 
cover.

33. Remove cover mounting 
screws from top and 
bottom of unit (quantity 8).

34.

34

Detach outer Source Cover 
ONLY.
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35.

36

Carefully detach and move 
inner Source Cover a few 
inches away from assembly.

36. Remove ribbon cable from 
Beam Limiter Assembly by 
depressing connector 
locking tab.

37.

38

Using very little force, 
slowly rotate gantry, 
counterclockwise. Stop the 
rotation when you feel that the 
gantry is at the limit switch 
position.

38. Slide X-ray Source Cover onto 
the Gantry overhead.
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WARNING
The X-ray Source Assembly requires a two person lift. Failure to 
comply may cause bodily injury.

39.

40

41

3/16

42

With an assistant, align X-ray 
Source Assembly mounting pins.

40. Attach assembly using the four 
mounting screws previously 
removed from red Shipping Plate 
along with four split washers.

41. Draw the 3 cables out through the 
opening. Ensure that the cables are 
not stretched or damaged.
• black cable (2 connectors)
• grey cable (single connector)
• green ground cable (ground lug)

42. Record label information that is 
required on Installation Sheet 
(Serial Number, etc.).

CAUTIONCAUTION
When mating connectors, do not force-fit together.

43.

43

44

45

Attach ground lug by removing 
mounting nut and installing lug 
over the star-lock washer. Replace 
mounting nut.

44. Attach together, black cables with 
the two connectors.

45. Attach grey wire with red/white 
connector as shown. Ensure red 
side of connector is facing 
upward.
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46.

46

Attach ribbon cable back to the 
Beam Limiter Assembly.

47.
47

48

49 3/32

Slide Adjustment Panel Cover 
into place, onto top mounting 
notches.

48. Mount outer cover onto mounting 
notches, over panel cover.

49. Attach covers with the four hex 
mounting screws at the bottom of 
assembly.

50.

9/64 50

Attach Scatter Shield to the rear of 
the Gantry (8 mounting screws). 
Note, mounting pins to be located at 
the top of the Scatter Shield. Obtain 
Mounting Bar Assembly.



5-15

System Assembly

G990710    30 June 2008

51.
51

53

53

Install Mounting Bar on wall, 
centered behind the unit. The height 
should be approximately 66 ½ to 68 
inches [169 to 173 cm] from the 
floor to the center of the Mounting 
Bar. However, this may vary, so you 
may want to put the “L” brackets on 
unit and mark the wall to verify the 
height.

52. Use 3 wall anchors/screws to mount 
the bar securely to the wall.

53. Loosely attach brackets to the unit 
and mounting bar. Do not tighten until leveling is complete.

54.

54

55
Connect chair Control Cable to 
CHAIR connector on rear of 
Overhead Panel.

55. Connect Main Control Box cable 
to CONTROL BOX connector on 
rear of Overhead Panel. 
Connectors are keyed to prevent 
improper insertion.

56.

5756

Connect chair Control Cable to 
Patient Chair connector.

57. Connect Patient Emergency Stop 
Control to Patient Chair connector. 
Connectors are keyed to prevent 
improper insertion.
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58.

5958 60

Connect Power Cable to AC 
POWER IN connector on rear of 
Overhead Panel.

59. Ensure the Power Circuit Breaker 
on the Overhead rear panel is set to 
the OFF position. The OFF 
position is the O symbol.

CAUTIONCAUTION
Connect to hospital grade power only. Otherwise, damage to 
equipment may occur.

60. Connect Power Cable to Hospital Grade Receptacle.

Install Computer and Monitor:
1. Power Switch

2. Power Cord Receptacle

3. Mouse (USB)

4. Keyboard (USB)

5. Acquisition Software 
Key 
(USB) can be found 
attached to Operator 
documentation.

6. Monitor

7. ACQ Computer Cable 
(connects to gantry rear)

NOTE: Use supplied Power Strip.

2

1

3

4

5

6

7

Acquisition Computer

Acquisition Software Key
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 6 Leveling and Alignment

Level Gantry
To achieve optimal performance, it is imperative that the Gantry be properly 
leveled.

Leveling the Gantry:
1. Remove top cover (6 screws).

2. Remove shielding cover.

3. Unit must be leveled from side-
to-side and front-to-back.

Level Side-to-Side Level Front-to-Back

13/32 2
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4.

4
1/4” Driver

Level Overhead Gear using 1/4” 
Hex Driver to adjust the front 
Gantry feet.

5.

5
1/2” Wrench

Adjust the rear Gantry feet using 
the 1/2” Open-ended Wrench.

NOTE: Ensure levelness of 
Overhead Gear is measured 
Front-to-Back and Side-to-
Side.

6.

6

Store red shipping bracket in 
Overhead.
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7.
7

Replace shielding cover.

8.
3/328

Replace top cover 
(6 screws).

9. Now that the device is 
positioned and leveled, tighten 
wall bracket at top rear of gantry.

10.

10

Switch the Power Circuit 
Breaker which is located on the 
Overhead rear panel to ON. The 
ON position is the l symbol.

11.

11

 Press the Control Box ON 
button. 
The device is now powered.

12. On the Acquisition Computer, start 
the Vision software.

NOTE: If the Vision software was started prior 
to powering up the scanner, then close and 
reopen Vision so that the device can reset 
properly.



6-4

Gendex GXCB-500TM Service Manual

G990710    30 June 2008

Patient Chair Alignment

To acquire quality images, the chair must be accurately leveled and 
aligned.

Leveling Patient Chair:
1. From the Acquisition computer, double click the 

Calibration icon.

The Calibration screen is displayed and the device 
moves to the home position.

2. Insert Chair Center Locator into positioning block.

3. Press the Alignment Light button on the Patient Alignment 
Panel to display lasers. 

4. Check position of the 
Horizontal and Vertical Lasers 
relative to the notches on the 
Chair Center Locator, as 
shown.

• If Horizontal Laser is out of 
position, move Chair 
Center Locator up or down 
in the positioning block to 
roughly align with 
horizontal notch.

• If the Vertical Laser is out of 
position, then adjust the Chair 
Foot, using a 1/4 inch nut driver.

• Turn nut driver clockwise - 
moves alignment tool towards 
rear of Scanner.

• Turn nut driver counter-
clockwise - moves alignment tool 
towards front of Scanner.

Ve
rt

ic
al

La
se

r

Horizontal
Laser

1/4

4
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5. On the Calibration screen, 
click the Vertical Chair Line 
checkbox and ensure slider is 
at 0o position.

6. Click Preview. A dialog is 
displayed.

7. Click OK to start the scan process.

WARNINGWARNING
The X-ray device may be dangerous to the Patient and operator if 
you do not observe and follow the safe exposure factors and 
operating instructions. Do not operate this system unless you have 
received training to perform a procedure.

8. Press Scan button on Control Box. An audible is sounded and 
the X-ray ON light is illuminated during radiation exposure. The 
preview scan is displayed.

9. Verify that the vertical pin 
falls within the blue shaded 
area. If aligned, go to next 
step.

If not aligned, adjust the 
Chair Foot (step 4), then 
perform a Preview (steps 6 - 
8). Repeat as needed until 
pin falls within the blue 
shaded area.

NOTE: If the pin falls to the left of the shaded area, turn the nut driver 
counter-clockwise.  If the pin falls to the right of the shaded area, 
turn the nut driver clockwise.
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Centering Patient Chair:
10. On the Calibration screen:

a. Move slider to 90o 
position and perform a 
Preview.

b. Verify that the vertical pin falls 
within the blue shaded area. If 
aligned, go to step 17.

11. If the pin is not within the 
blue shaded area, loosen 
set screw (rear of 
Scanner), then loosen the 
Chair mounting bolts  by 
1/2 turn each.

12. Adjust chair, left or right, 
as needed based on the 
Preview scan using the 
Adjustment Screw on the 
side of Chair Assembly.

• If pin is to left of shaded area, turn wrench clockwise - 
moves Chair Assembly to the left when facing front of 
Scanner.

• If pin is to right of shaded area, turn wrench counter-
clockwise - moves Chair Assembly to the right when facing 
front of Scanner.

3/16

11

1/8

3/16
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13. Repeat Preview and Chair Assembly adjustment (step 12) as 
needed until pin is within blue shaded area on Preview scan.

14. When pin falls within the blue shaded area at both 0o and 90o, 
tighten Chair mounting bolts.

NOTE: Tightening the left bolt first (when facing rear of Scanner) 
may help prevent the Chair Assembly from shifting.

15. After Chair Assembly mounting bolts are tightened, repeat 
Preview scans at 0o and 90o to verify chair alignment.

16. If the vertical pin falls outside the blue shaded area at either 
position, repeat the necessary steps to adjust the Chair, and 
perform a Preview, until chair alignment is verified. Tighten set 
screw at rear of Scanner.

17. Uncheck the Vertical Chair Line checkbox.
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Laser Alignments
The scanner has two alignment lasers.

•  Centerline Laser - located on the front of Overhead Gantry
•  Crosshair Laser - housed inside the X-ray Source Assembly.

WARNING
Do not stare into laser. Severe personal injury (blindness) may 
result.

NOTE: Ensure that the Patient Chair Alignment has been completed 
before beginning this procedure.

Adjust Centerline Laser
There are three laser adjustments;

• Right-to Left
• Angle
• Laser Line Sharpness.

RIGHT-TO-LEFT ANGLE
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Right-to-Left Adjustment:
1. Loosen laser assembly set screw 

which allows the assembly to 
rotate.

2. Press the ALIGNMENT 
LIGHT button on the Operator 
Panel. The laser lights for 
approximately two minutes.

3.

3

While the laser is lit, manually 
rotate the laser assembly until it is 
aligned with the center line on the Chair 
Center Locator.

4. While holding the assembly in place, 
firmly tighten set screw.

Angle Adjustment:
1. Loosen laser pointer set screw.

2. Press the ALIGNMENT LIGHT 
button on the Operator Panel.

3. While the laser is lit, manually rotate the 
laser pointer until it is aligned with the 
center line on the Chair Center Locator.

4. While holding the laser pointer in place, 
firmly tighten set screw.

1

5/32

13/32

3
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Laser Line Sharpness Adjustment:
1. Loosen laser pointer lens set screw.

2. Press the ALIGNMENT LIGHT 
button on the Operator Panel.

3. Manually rotate laser pointer lens with 
your finger tip until laser line is thin and 
sharp. 
 
Rotating the lens for sharpness will 
require realignment (Side-to-Side and/or Angle).

4. Tighten set screw to lock lens in place.

1

1/16

3
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Adjust Crosshair Laser

When the ALIGNMENT LIGHT button is pressed, the Crosshair 
Laser shines from the X-ray Source Panel and appears on the 
Receptor Panel. The crosshairs should appear directly in line with 
the four notches on the panel cover, as shown below.

There are three types of laser adjustments:

• Horizontal Line up/down
• Vertical Line forward/back
• Rotate Crosshairs.

1.

1

Remove Beam Limiter Cover 
to gain access to the 
Crosshair Laser. 
 
The cover is attached 
magnetically.

NOTCH

NOTCH

NOTCH

NOTCH

Horizontal
Vertical
Rotation

ADJUSTMENTS



6-12

Gendex GXCB-500TM Service Manual

G990710    30 June 2008

Horizontal Line Adjustment:
2. Check height of horizontal 

crosshair line with panel 
cover notches.

3.

3

5/32

To move horizontal laser line 
up/down turn adjustment 
screw (shown):

• Clockwise - moves line up

• CCW - moves line down

Vertical Line Adjustment:
4. Check position of vertical 

crosshair line with panel 
cover notches.

2 NOTCHNOTCH

4

NOTCH

NOTCH
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5.
5 5/32

To move vertical laser line 
forward/back loosen the two 
mounting screws (shown). 
The bracket pivots on the 
center mounting screw which 
moves the vertical laser line.

6. Tighten both screws when 
properly aligned.

Rotate Crosshair Laser Lines:
7. Check crosshair lines with 

panel cover notches to see if a 
rotation adjustment is 
required.

8.

8 5/32 9 3/32

To rotate laser crosshairs 
slightly loosen the two laser 
mounting screws (shown).

9. To help rotate the laser, insert 
an allen wrench (3/32) into 
the top hole of the laser.

10. Tighten both screws when 
properly aligned and remove 
3/32 allen wrench.

11. Replace Beam Limiter 
Cover.

7
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Head Holder Alignment

NOTE: Ensure that the Laser Alignments have been completed 
before beginning this procedure.

1.
3LASER

LINE

If head support is installed, loosen locking knob 
and remove head support.

2. Slide head holder into place.

3. Place the Position Alignment tool between the 
temple pads with the alignment mark facing front.

4. Press the ALIGNMENT LIGHT button on the 
Operator Panel to turn on laser.

5.

5 5/32

Loosen screws underneath head holder with allen 
wrench (5/32) and adjust the head holder so that the 
laser aligns with the alignment mark.

6. When aligned, re-tighten screws.

7. Press the Push To Release lever to open arms and 
remove the Position Alignment tool. Do not 
manually force arms open.

8. Remove head holder and re-install head support.
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 7 Calibration

The Panel, Collimators, and Geometry Calibrations can be 
conducted by the Owner / Operator of the device. It is recommended 
that the Panel Calibration be performed once a week.

Panel Calibration

The Panel Calibration is performed for both Portrait and Landscape 
positions. The entire calibration takes approximately 8 to 10 minutes 
to complete. The process performs a five mode calibration as listed 
below:

• Mode 0 (4 x 4) Landscape 

• Mode 1 (2 x 2) Landscape

• Mode 2 (not supported)

• Mode 3 (2 x 2) PAN (Landscape)

• Mode 4 (not supported)

• Mode 5 (4 x 4) Portrait

• Mode 6 (2 x 2) Portrait

To run the Panel Calibration:
1. Ensure room temperature is in the range of 50 to 95oF (10 to 

35oC).

2. From the desktop, double click the Calibration 
icon.
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The Calibration screen is displayed.

3. Click the Calibrate button (top) in the Panel field.

WARNING
The X-ray device may be dangerous to the Patient and operator if 
you do not observe and follow the operating instructions. Do not 
operate this system unless you have received training to perform a 
procedure.

A window is displayed “Remove all objects from the field of 
view and click OK to start X-ray exposure.”

4. Click OK. 

5. When prompted, press the Scan button on the Control Box. An 
audible alarm is sounded and the X-ray ON light is illuminated 
during radiation exposure.

6. The progress of the scan is displayed on the Progress bar at the 
bottom of the Acquire window. You will be prompted to press 
the Scan button several times as the calibration progresses.

“Panel Calibration Complete” is displayed when the process is 
finished. Click OK.
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Collimators Calibration

It is recommended to perform the Collimators Calibration annually 
to ensure optimal image quality. This calibration is also necessary if 
a mechancial adjustment is made to the Beam Limiter or if image 
quality has degraded. The Panel Calibration must be performed prior 
to this. The Collimator Calibration runs in both Portrait and 
Landscape positions and takes less than 3 minutes to complete.

Perform Collimators Calibration:

7. After performing the Panel Calibration click the Calibrate 
(middle) button in the Collimators field.

WARNINGWARNING
The X-ray device may be dangerous to the Patient and operator if 
you do not observe and follow the operating instructions. Do not 
operate this system unless you have received training to perform a 
procedure.

A window is displayed “Starting Collimator Calibration 
Remove all objects from the field of view and click OK to start 
X-ray exposure.”

8. Click OK to start the X-ray exposure.

9. On the Control Box, press 
Scan when prompted. An 
audible alarm is sounded 
and the X-ray ON light is 
illuminated during 
radiation exposure.

10. The scan starts in the 
Landscape and continues 
into the Portrait mode, 
displaying three screen 
shots in both modes.

11. Click OK when calibration 
completes (less than 3 minutes)
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Geometry Calibration

It is recommended to perform the Geometry Calibration annually to 
ensure optimal image quality or if the image quality is degraded. The 
Panel Calibration must be performed prior to this. The Geometry 
Calibration runs in both Portrait and Landscape positions and takes 
about 12 to 15 minutes to complete.

Perform Geometry Calibration:

12. Use the Back / Front feature to ensure the Panel is set to the 
back.

13. Place BB Phantom on a piece of foam and center the phantom on 
the platform.

14. Ensure that the BB Phantom is level. Use shims or pieces of 
paper under the phantom to level it if necessary.

15. Center the BB Phantom (left to right) using the Front Laser.

16. Align the BB Phantom crosshair slits so that the laser beams 
penetrate through the phantom crosshair slits and appear on the 
receptor panel.
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17.  Click the Preview button which is located at the bottom of the 
Calibration screen.

WARNINGWARNING
The X-ray device may be dangerous to the Patient and operator if 
you do not observe and follow the operating instructions. Do not 
operate this system unless you have received training to perform a 
procedure.

18. The ready window is displayed, click OK.

19. On the Control Box, press Scan when prompted. An audible 
alarm is sounded and the X-ray light illuminates during radiation 
exposure.

20. The BB Phantom image is displayed (shown below).

21. Ensure that the phantom is centered, level, and all BBs (dots) 
appear in the Field of View. If required, make adjustments and 
click Preview again. Repeat as required.

Height adjustments are made by raising or lowering the phantom 
platform. BBs should not touch the top or bottom FOV.

22. When the BB Phantom is centered and level, click the Calibrate 
button on the Geometry panel (bottom).

Back
(Volume Center)

Front
(Volume Center)



7-6

Gendex GXCB-500TM Service Manual

G990710    30 June 2008

23. Select both the Landscape and Portrait calibrate modes.

WARNINGWARNING
The X-ray device may be dangerous to the Patient and operator if 
you do not observe and follow the operating instructions. Do not 
operate this system unless you have received training to perform a 
procedure.

24. Click OK to start the X-ray exposure.

25. On the Control Box, press Scan when prompted. An audible 
alarm is sounded and the X-ray ON light is illuminated during 
radiation exposure.

26. The calibration starts with the Landscape Scan.

NOTE: Ensure that the metal platform support is below the Field of 
View (as shown above.)

27. At the start of the scan, red circles are displayed around each BB. 
At this point, check data (above green progress bar), to ensure 
the following is displayed:

LANDSCAPE SCAN PORTRAIT SCAN

Metal Platform Support
(below FOV)
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Beads detected = 12, Beads valid = 12

28. At the prompt, press Scan on the Control Box, to start the 
Portrait Scan.

29. During the Portrait Scan, ensure the following is displayed:

Beads detected = 8, Beads valid = 8

NOTE: Check to ensure that all beads are intact on the BB Phantom, 
if the calibration did not detect a bead at a certain location.

Checking Detector Pivot:.
30. On the Geometry Calbration screen, check the Detector Pivot in 

both the Portrait and Landscape positions.

The measurement must fall between: -0.10 and 0.10

Detector Pivot Adjustment (Receptor Panel) on page 9-1, is required 
if the Detector Pivot is not within tolerance.

31. Click OK when the completion window is displayed and restart 
Vision software.

CAUTIONCAUTION
Failure to restart Vision software at this point may result in a 
system failure.
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Chapter

 8 Quality Assurance

QA Phantom Test
The following Quality Assurance Tests can be conducted by the Owner / Operator 
of the device. It is recommended that the System Quality Assurance be performed 
annually or if image quality becomes degraded. For this purpose, the following 
procedures are provided with a QA Phantom Test and QA Water Test.

This procedure is performed to check the High Contrast Spatial Resolution.

1. Remove Chin Cup and insert Phantom Platform.

2. Place QA Phantom on Platform. Use a piece of foam beneath the 
phantom to elevate it.

3. Use the alignment lasers to adjust the Phantom Platform height.

Adjust the height so that the Horizontal Laser is positioned at the 
center of the QA Phantom.

Horizontal Laser Line Across 
Center of Phantom
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4. Center the QA Phantom on the platform with the Air Hole 
positioned at the left front of the Gantry (shown below).

5. Start the test by selecting File > New Patient from the Main 
menu.

6. From the Patient Information Panel, click Add.

Enter QA Test in the First Name field and Line Pair in the 
Patient ID field.

7. Click OK to close the Patient Information box.

8. From the Volume tab, select the following:

Size of Reconstruction Volume: Dia 8.5 - H 8.5 cm
Resolution: .2 voxel

WARNINGWARNING
The X-ray device may be dangerous to the Patient and operator if 
you do not observe and follow the operating instructions. Do not 
operate this system unless you have received training to perform a 
procedure.

9. Click Preview to check the phantom position.

10. Click OK and press the Scan button on the Control Box when 
prompted. An audible alarm is sounded and the X-ray ON light 
is illuminated during radiation exposure.

AIR HOLE

ACRYLIC

TEFLON

LDPE



8-3

11. The Phantom Platform must appear below the Field of View and 
the Phantom must be centered. Adjust the Phantom Platform to 
achieve the proper height.

12. To move the phantom to the right or left, use the Back / Front 
feature.

If required, make adjustments and click Preview again. Repeat 
as required.

WARNINGWARNING
The X-ray device may be dangerous to the Patient and operator if 
you do not observe and follow the operating instructions. Do not 
operate this system unless you have received training to perform a 
procedure.

13. Click Capture to start the scan process.

14. Click OK and press the Scan button on the Control Box when 
prompted. An audible alarm is sounded and the X-ray ON light 
is illuminated during radiation exposure.

15. When the scan is completed, select NO when prompted to 
automatically detect arches.

16. Select Cancel at the Contourline Setup prompt.
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17.  The following preview screen is displayed.
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Line Pair Evaluation

18. Access the QA Test images for evaluation by double clicking 
Coronal View (bottom image, 2nd from the right).

19. The image below is displayed. In the top-right corner view, slide 
the Vertical and Horizontal lines to the Line Pairs centers as 
shown below.
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20. Zoom Line Pair image (top- 
left). To zoom, start at the upper 
right corner of image and hold 
down left mouse button and drag 
cursor across the image.

21. Right click the image and select 
Set Filter > Hard.

22. Adjust Brightness and Contrast 
level for the best image quality. 
Evaluate the image.

Line Pair - Line Pairs consists 
of a resolution of 10 lines per cm 
(5 dark with 5 light). Line Pairs 
12 through 18 are displayed in 
the image.

The picture depicts expected 
appearance of the Line Pairs 
per cm present within the QA 
Phantom.

23. Verify that definition is present 
within line pairs 12, 13, and 14. 
Compare image quality to the 
image shown at right.

18

17

16

15

14

13

12
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Distance Measurement Test

To ensure measurement 
accuracy, this procedure 
verifies that the Distance tool 
is functioning properly.

24. Right click view and 
select Distance.

25. Drag the Distance cursor 
to draw a line from the 
outside line of set 18 to 
the outside line of set 12, 
as shown.

26. The measurement 
(displayed in upper corner 
of image) should be 
between 38 and 39 mm.

27. Call Technical Support, if 
the measured value is not 
within this range.

Hounsfield Unit (HU) Measurements

This procedure checks density consistency in various 
measurements. The positioning and dimension of each Region of 
Interest (ROI) is very important. Be consistent between each 
assessment to achieve the minimum deviation.

28. Perform a second scan (described in steps 5 - 16) using the 
following settings:

On Patient Information panel:
Enter QA Test in the First Name field and Hounsfield in the 
Patient ID field.

On the Volume tab:
Size of Reconstruction Volume: Dia 8.5 - H 8.5 cm
Resolution: .4 voxel

Distance 
Line
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29. From the preview scan, access the QA Test images for 
evaluation by double clicking Coronal View. (bottom image, 
2nd from the right).

30. In the top-right image of the Coronal View, slide the Horizontal 
line up to bring the Housfield Unit centers into view.  In the top-
left image, slide the Vertical and Horizontal lines to the 
Hounsfield Unit centers as shown below.

31. Zoom the top-left image. To zoom, start at the lower right corner 
of the image and hold down left mouse button and drag the 
cursor across the image.

For consistency, ensure that the slice selection to be measured is 
setup as follows.

a. Right click top-left image and select Set Filter > Normal

b. At the bottom of the top-right image scale, click and hold 
the cursor on the ● symbol. The slice thickness is displayed. 
Slide the cursor up to change the value to 0.4 mm.
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c. Move the position of the slice to the middle of the phantom 
on the top-left image as shown below.

32. Right click the image and select HU Statistics from the menu 
(also, right click to turn off HU Statistics).

33. Area of ROIs should be at least 40mm2 but less than 46mm2.

Use the Region Tool to define a ROI in the center of each circle 
of material implanted within the QA phantom.

34. Record the Hounsfield value of each material. See table below.

35. Call Service, if any of the four measured values exceed the 
Lower or Higher limit.

 
Material

Mean Scan Value 
(Hounsfield Units)

Lower 
Limit

Upper 
Limit

Mean 

Air (Black) -1000 -980 -990

Acrylic (Light Gray) 75 125 100

LDPE (Dark Gray) -175 -115 -145

Teflon (White) 1055 1205 1130
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QA Water Phantom Test
The Water Phantom Test is a noise level and uniformity test which 
uses both water and air as a measuring tool. It is important that the 
Water Phantom provided is used for these tests.

1. Remove Chin Cup and insert Phantom Platform.

2. Fill Phantom with distilled water to a level between 60 and 75% 
of the container height.  

3. Place a plastic or foam layer on top of platform. Place Phantom 
on top of layer.  

4. Level Phantom with a spirit level and non-metal shims, if 
necessary.

5. Using the Alignment Lasers, center the water bath with the 
horizontal laser across the center of the water depth.

Noise Level Test in Landscape Mode

6. Start test by selecting File > New Patient from the Main menu.

7. From the Patient Information Panel, click Add.
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Enter Water Calibration in the First Name field and Noise Test 
Landscape in the Patient ID field.

8. Click OK to close the Patient Information box.

9. From the Volume tab select the following:

Size of Reconstruction Volume: Dia 8.5 - H 8.5 cm
Resolution: 0.4 voxel

WARNINGWARNING
The X-ray device may be dangerous to the Patient and operator if 
you do not observe and follow the operating instructions. Do not 
operate this system unless you have received training to perform a 
procedure.

10. Click Capture to start the scan process.

11. Click OK at the prompt to continue.

12. Press the Scan button on the Control Box when prompted. An 
audible alarm is sounded and the X-ray ON light is illuminated 
during radiation exposure.

13. At the Contourline prompt, select No and Cancel.

14. Access the HU measurement image for evaluation by double 
clicking Coronal View (bottom image, 2nd from the right).

15. In the top-right image of Coronal view, slide the Horizontal line 
to the middle of the water height.
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16. At the bottomof the top-right image scale, click and hold the 
cursor on the ● symbol. The slice thickness is displayed. Slide 
the cursor up to change the value to 0.4 mm.

17. In the top-left screen, right click the image area and select HU 
Statistics from the menu (also, right click to turn off HU 
Statistics).

Use the Region Tool to define a ROI (Region of Interest) in the 
center of Water, as shown above.

HU Area (box size) should be approximately 400.0 mm2

18. Record the Water HU Mean and Standard Deviation values in 
the table below.

19. Right click the HU measurements and select Remove all 
Measurements.
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20. In the top-right screen, move the red dotted line upward, so the 
line is located at the top of the phantom, above the water level.

21. In the top-left screen, right click the image area and select HU 
Statistics from the menu (also, right click to turn off HU 
Statistics).

Use the Region Tool to define a ROI (Region of Interest) in the 
center of Air, as shown above.

HU Area (box size) should be approximately 400.0 mm2 

22. Record the Air HU Mean and Standard Deviation values in the 
table below.

23. Right click the HU measurement and select Remove all 
Measurements.

Measured Values Water Air

Mean

Expected Values 0 (-70 to +70) -1000 (-930 to -1000)

SD
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Uniformity Test in Landscape Mode
The Uniformity Test is to ensure that image density measurements 
are consistent in all areas within the Field of View.

24. Move the red, green, and blue dotted lines to the center of the 
water (all screens) as shown below. Use the Center Line 
Positioning tool to make these adjustments.

25. Right click the image and select HU Statistics from the menu 
(also, right click to turn off HU Statistics).

Use the Region Tool to define a ROI (Region of Interest) in four 
areas of Water, as shown above.

NOTE: Only four regions can be displayed at one time. Creating a 
fifth region overwrites the first.

The HU Area (box size) should be approximately 100.0 mm2.

26. Note and record the Mean and SD values of the four regions. See 
chart below.

27. After recording values, a fifth ROI is required from the center 
of the water area. The fifth measurement replaces the first 
measurement, since four measurements are the limit.
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28. Note and record the Mean and SD values of the center ROI.

Subtract each Mean Value from the Mean Value of the center 
ROI. If any difference is greater than 90, make sure phantom is 
correctly centered in FOV and re-measure. If the difference is 
still greater than 90, call Technical Support.

29. Right click the HU measurement and select Remove all 
Measurements.

Noise Level Test in Half-Beam Mode

30. Start test by selecting File > New Patient from the Main menu.

31. From the Patient Information Panel, click Add.

Enter Water Calibration in the First Name field and Noise Test 
Half-Beam in the Patient ID field.

32. Click OK to close the Patient Information box.

33. From the Volume tab select the following:

Size of Reconstruction Volume: Dia 14 - H 8.5 cm
Resolution: 0.4 voxel

WARNINGWARNING
The X-ray device may be dangerous to the Patient and operator if 
you do not observe and follow the operating instructions. Do not 
operate this system unless you have received training to perform a 
procedure.

34. Click Capture to start the scan process and OK at the prompt to 
continue.

35. Press the Scan button on the Control Box when prompted. An 
audible alarm is sounded and the X-ray ON light is illuminated 
during radiation exposure.

Measured 
Values

Upper 
Left

Upper 
Right

Lower 
Left

Lower 
Right

Center

Mean

SD
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36. At the Contourline prompt, select No and Cancel.

37. Access the HU measurement image for evaluation by double 
clicking Coronal View (bottom image, 2nd from the right).

38. In the top-right screen, slide the Horizontal line to the middle of 
the water height.

39. At the bottomof the top-right image scale, click and hold the 
cursor on the ● symbol. The slice thickness is displayed. Slide 
the cursor up to change the value to 0.4 mm.
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40. In the top-left image, right click the image area and select HU 
Statistics from the menu (also, right click to turn off HU 
Statistics).

Use the Region Tool to define a ROI (Region of Interest) in the 
center of Water, as shown above.

HU Area (box size) should be approximately 400.0 mm2

41. Record the water HU Mean and Standard Deviation values in the 
table below.

42. Right click the HU measurement and select Remove 
Measurement.

43. Move the red dotted line upward (top-right screen) so the line is 
located at the top of the phantom, above the water level.

44. In the top-left image, right click the image area and select HU 
Statistics from the menu (also, right click to turn off HU 
Statistics).

Use the Region Tool to define a ROI (Region of Interest) in the 
center of Air, as shown above.

HU Area (box size) should be approximately 400.0 mm2 
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Record the air HU Mean value in the table below.

45. Right click the HU measurement and select Remove 
Measurement.

Uniformity Test in Half-Beam Mode
The Uniformity Test is to ensure that image density measurements 
are consistent in all areas within the Field of View.

46. Move the red, green, and blue dotted lines to the center of the 
water (all screens) as shown below. Use the Center Line 
Positioning tool to make these adjustments.

47. Right click the image and select HU Statistics from the menu 
(also, right click to turn off HU Statistics).

Use the Region Tool to define a ROI (Region of Interest) in four 
areas of Water, as shown above.

NOTE: Only four regions can be displayed at one time. Creating a 
fifth region overwrites the first.

The HU Area (box size) should be approximately 100.0 mm2.

Measured Values Water Air

Mean

Expected Values 0 (-70 to + 70) -1000 (-930 to -1000)

SD
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48. Note and record the Mean and SD values of the four regions. See 
chart below.

49. After recording values, a fifth ROI is required from the center 
of the water area. The fifth measurement replaces the first 
measurement, since four measurements are the limit.

50. Note and record the Mean and SD values of the center ROI.

Subtract each Mean Value from the Mean Value of the center 
ROI. If any difference is greater than 90, make sure phantom is 
correctly centered in FOV and re-measure.  If the difference is 
still greater than 90, call Technical Support.

Measured 
Values

Upper 
Left

Upper 
Right

Lower 
Left

Lower 
Right

Center

Mean

SD
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PAN Phantom Test

PAN Phantom Test is used to validate the PAN scan data capture.

To perform a PAN Phantom Test:
1. Prepare the Bite Tip by inserting the narrow edges of the Bite 

Tip down into the Bite Tip Holder uprights. Then turn the Bite 
Tip a 1/4 turn to lock into place.

2. Insert the Phantom Platform and Bite Tip Holder into the 
Positioning Block. The Bite Tip should rest on top of the 
platform.

3. Place PAN Phantom on platform with balls facing up and top of 
arch resting on Bite Tip.

4. Press the Alignment Light button on the Patient Alignment 
Panel to display lasers. Use the Horizontal Laser to adjust the 
height of the phantom as shown below. Use the Vertical Laser to 
center the phantom on the platform.

Lasers are available while the Volume tab is selected (not PAN ).

5. Start test by selecting File > New Patient from the Main menu 
or right click an existing image from database and select 
Acquire New Scan.

6. From the Patient Information Panel, click Add.

PAN
PHANTOM

PHANTOM PLATFORM

BITE TIP HOLDER

BITE TIP

LASER

LINE
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Enter PAN Test in the First Name field and QA in the Patient 
ID field.

7. Click OK to close the Patient Information box.

8. Click the Pan tab in the Acquisition window and select, 
Exposure: Large

9. Click the Capture button to start the test.

WARNINGWARNING
The X-ray device may be dangerous to the Patient and operator if 
you do not observe and follow the operating instructions. Do not 
operate this system unless you have received training to perform a 
procedure.

10. The system moves approximately 1/4 rotation to the Home 
Position and then displays the scan parameters.

11. Click OK to start the scan process.

12. Press Scan button on Control Box. An audible alarm is sounded 
and the X-ray ON light is illuminated during radiation exposure.
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13. The PAN scan runs a few minutes and then displays the 
reconstructed image.

14. Adjust the Brightness/Contrast by dragging the cursor across the 
image (vertical/horizontal). All seven metal balls should become 
visible as shown below.

15. The image above is an example of a system properly aligned for 
PAN scanning. All but two of the metal balls are circular in 
shape.

16. The image above is an example of a system that is not properly 
aligned for PAN scanning. This is easily seen by the fact that 
only two metal balls are circular. Elongation of the Metal Balls 
indicate that the phantom is not in the middle of the focal trough 
due to poor chair alignment.

17. Check chair alignment if all seven balls do not appear circular.

Good Image Quality

Poor Image Quality
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Radiation Output Test

It is recommended that a check of the kVp(eff) and Radiation Output 
of the X-ray source be performed annually by a qualified Physicist.

The incident Absorbed Dose at the detector may be measured using 
a dosimeter. Tests are performed to assess output value and to check 
for tube output consistency and timer accuracy.

1. Attach a dosimeter to the detector such that the sensor is 
positioned where the vertical (coronal) and horizontal (axial) 
lasers intersect.

2. Perform a standard 8.9 second, 8.5 diameter,14 cm, 0.4 voxel 
scan and record time and dose from meter.

Measured Dose

The table below shows measurements performed on the detector for 
a Landscape mode standard scan.

Tube Potential (kV) 120

Selected Scan Time (seconds) 8.9

Number of Frames 309

Approximate Exposure Time (seconds) 5.7

Displayed mAs 28.52

Measured Exposure at Detector (mR) 325.5

Measured Exposure at Detector / mAs (mR/mAs) 11.41

Measured Exposure at 1m (mR/mAs) 5.28

Measured Dose at 1m (μGy/mAs) 46.23

Dose at Detector per Frame (μGy/fr) 9.23

Tube Output (μGy/mAs @ 1m) 46.23

Distance Source to Detector (cm) 68.0

Conversion Factor for Absorbed Dose (R to Gy) 0.00876
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Interpretation

1. The dose per frame at the detector may be calculated by:

Dose per frame at Detector = Dose at Detector / Number of 
Frames

Where Number of Frames = 309 for 8.9 second scan

= 619 for 23.0 second scan

2. The tube output per mAs may be normalized to 1m using the 
inverse square law for the purposes of assessing consistency of 
tube output:

Tube Output (μGy/mAs) = Dose at Detector x (Source to detector distance)2

 Displayed mAs

Where Source to detector distance = 0.68m for the system.
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Chapter

 9 Troubleshooting and 
Adjustments

Detector Pivot Adjustment (Receptor Panel)

The Receptor Panel must be on level-plane as the Source Panel in both the Portrait 
and Landscape positions. The Geometric Calibration shows if the Receptor Panel is 
properly aligned.

Checking Detector Pivot:.
1. On the Geometry 

Calibration screen, check 
the Detector Pivot in 
both the Portrait and 
Landscape positions.

The measurement must 
fall between: 
-0.10 and 0.10

If a Pivot Detector adjustment is 
required:

1

1
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2.

3/322

Remove two mounting 
screws from the top and 
bottom and remove 
Receptor Cover.

3.

3

4

3

3/32

3/16

3/16

On the Receptor 
Assembly, loosen the 
two panel mounting 
screws.

4. One Leveling Screw is 
used to adjust the 
Detector Pivot for both 
Landscape and Portrait 
simultaneously.

Turning the Leveling 
Screw one full turn is an 
adjustment of .4

A clockwise adjustment 
adds to the displayed 
number.

Counter-clockwise 
subtracts from the displayed number.

5. Tighten the mounting screws after the adjustment is made.

6. Install Receptor Cover.
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IEC IC Command Codes

Home Commands
HB Home Beam Limiter 

(HB = 0, 0, 0, 0 All four shutters completely open)

HFR Homes gantry and sets position to 100000

HP Homes gantry and sets position to 1500

HSR Quick home check if the machine is already homed

Movement Commands

MB Move Beam Limiter right left top bottom
Enter command as MB X X X X where X is:
(right left and bottom shutters range: 0 – 2600)
(top shutter range: 0 – 3300)

Example: MB 700 700 3000 1500

MP Move Platform [target] [speed]
Enter command as MP X X where X is:
(target range: 1500 – 100000, speed range: 1000 – 54000)

Example: MP 1500 1500
MPM Target Speed.

Enter command as MPM X X where X is:
Target or Position: between 0 - 90 mm (home position is zero 
- absolute)
Speed: between 1000-54000

Example: MPM 20 1500
MPP Position type, moves receptor panel’s position.

Enter command as MPP X X where X is:
Position: 0 or 1 (Landscape or Portrait/Halfbeam)
Type: 0 or 1 (Platinum or Nano)

Example: MPP 1 0
MR Target Speed. 

Enter command as MR X X where X is:
Target: between 35000 - 733333
Speed: between 1000 - 65000

Example: MR 35000 1000
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MRD Target Speed.
Enter command as MRD X X where X is:
Target: between -40 - 430 degrees (home position is equal to 
zero degrees - absolute)
Type: between 1000 - 65000

Example: MRD 180 1000

Read Commands

RB Read beam position 
returns right left top bottom shutter positions

RD Read Door Status: 1 -Open and 0 -Closed

RE Read Exception Register

Exceptions
1 Emergency Stop activated
2 Stall Detected
4 X-ray Tube Short
8 X-ray Watchdog Timeout

16 Linux Watchdog Error
32 X-ray Fault from X-ray Controller
64 Platform needs to be Homed

128 Rotation needs to be Homed
256 Beam Limiter Not Initialized
512 Machine is Turned Off

1024 Door Interlock was Opened During an X-ray Exposure
2048 Ethernet Cable Communication Failed During an X-ray 

Exposure

4096 The Panel Position error - both limit switches are reading 
high or low

RI Read Input Register to the RI
Read Input Command - returns the 21 bit input register 
with the following definition:
1 Emergency Stop
2 Machine On Switch
4 Machine Off Switch
8 Scan Enable Button Status

16 Error from X-ray Controller
32 Encoder Direction
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64 Rotation Optical Switch Status
128 Rotation Limit Switch
256 Rotation Start of Travel Status
512 Rotation End of Travel Status

1024 Platform Start of Travel Status
2048 Platform End of Travel Status
4096 Door Signal
8192 Panel Horizontal (Landscape)

16384 Panel Vertical (Portrait)
32768 Machine Power Status
65536 Right Shutter Limit Switch

131072 Left Shutter Limit Switch
262144 Top Shutter Limit Switch
524288 Bottom Shutter Limit Switch

1048576 Moving Signal for Panel Flip Motion
2097152 Moving Signal for Rotation Motion
4194304 Moving Signal for Platform Motion

RMS Read usage time of selected item
Returns xxxxdxxhxxmxxs
0 Beam Limiter Motors
1 Embedded Board
2 Panel
3 Platform Motor
4 24V Power Supply
5 Rotation Motor
6 X-ray
7 Flipper Motor

RP Read Platform position

RPP Read Panel Position
0 Error
1 Landscape mode
2 Portrait mode
3 Error

RR Read Rotation position.
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RX Read X-ray Setup
See SX command for argument description. 
0 = 120KV Range 1 = 90 KV Range 
If no parameter is entered, then the command assumes 0.

SP Sets platform position - Sets the counts of the platform.
Must be less than 65000.

SR Sets rotation position - Sets the counts of the rotation.
Must be less than 733333.

SX Set X-ray
kvp, ma, frame rate, xrayon, xrayoff, panel readout, 
panel_mode 
Enter command as SX X1 X2 X3 X4 X5 X6 X7 X8 where 
X is:
X1 specifies kV = 80 - 126 in increments of 2 only.
X2 specifies mA = 0-2. 0=3mA, 1=5mA, 2=7mA 
X3 specifies frame rate = in between 50000000 - 833333 
=> 50 MHz/frame rate (1-60 frames/sec) 
X4 specifies X-ray on = typically set to 1 and between 0 - 
(frame rate - 1) 
X5 specifies X-ray off => greater than X-ray on and less than 
(frame rate - 1) 5000 =1 msec (set as needed for desired 
 length) 
X6 specifies Panel Readout = Typically set the same as the 
X-ray off (except for continuous X-ray mode) in between  
0 - (frame rate - 1) 
X7 specifies Panel Pulse mode (0 or 1) (if not entered, 
defaults to 0).  
0 - 20 microsecond pulse for panel readout and valid frame. 
1 - either a 5msec pulse for valid frame or 3msec for  
panel readout 
X8 specifies the tube 0 = 120 KV tube, 1 = 90 KV tube 
Example: SX 120 1 3333333 1 780000 780000 0 
If X7 and X8 are not specified, both are assumed to be zero.

X-Ray Commands

XP Frames
Maximum limit capped by the 44 second x-ray watchdog 
Number of frames: 1 - 1024 
Ethernet Watchdog 0 = disabled, 1 = enabled 
(Number of frames*Frame Rate) <44 seconds
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Miscellaneous Commands

GS Read System Information 
Machine Version, Hardware Version, Software Version 
Beam Limiter Version, Machine Serial Number 

CS Cancel Scan. 
Cancels a scan.

CE Clear Exception Register.
Clears all exceptions except for error that require 
 initialization.

WSB Enable Scan Button.
Enables the scan button to initiate a scan.
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 10 Wall Mount Control Box

The Control Box is configured for desktop usage but can be 
modified for wall mounting access.

Wall Mount with Cable Exposed

1.

1

Control Box cable is to be 
disconnected from rear of 
Overhead Panel.

Desktop Wall Mounted
(cable exposed)

Wall Mounted
(cable inside wall)
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2.

2

Using a fine tip Phillips 
screwdriver, loosen four mounting 
screws on rear of Control Box.

3.

3

Rotate Control Box face 
plate 90o, being careful 
not to over extend the 
ribbon cable.

4.

4

Tighten four mounting 
screws.
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5.

5 6

Mount Wall Bracket, 
using supplied mounting 
hardware (3 places).

6. Hang Control Box onto 
wall mount bracket.

The Control Box can be 
lifted from the wall for 
mobility. For a stationary 
mount see next 
procedure.

For a Stationary Mount
7. Draw center marks in the two 

tab slots at the rear of the base.

8. Drill two 3/32” pilot holes.

9.

9

With the Control Box 
positioned on wall bracket, 
install the two self-tapping 
screws (supplied with wall 
bracket).

Refer to install diagram 
(supplied with wall bracket).

7



10-4

Gendex GXCB-500TM Service Manual

G990710    30 June 2008

Wall Mount with Cable Inside Wall

1.

1

Control Box cable is to be 
disconnected from rear of 
Overhead Panel.

2.

2

Using a fine tip Phillips 
screwdriver, loosen four mounting 
screws on rear of Control Box.

3.

3

lift the face panel from 
the base, being careful 
not to over extend the 
ribbon cable.
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4.

5

4

Disconnect the 
Emergency Stop wires 
by simply pulling the 
black connectors apart.

5. Disconnect Ribbon 
Cable by pulling the 
black and red connectors 
apart.

6.

6

Remove pin assembly 
from red connector.

7.

7

Snap-off white plastic 
cap from red connector.
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8.

8
9

Loosen and remove plastic 
retaining nut from strain relief.

9. Remove black insert from 
base.

10. Remove cable from Control 
Box by carefully feeding 
connectors thru the access 
hole.

11.

12
11

Protect wires and connectors 
by wrapping them in 
electrical tape if feeding this 
end thru the wall.

12. Mount Wall Bracket, using 
supplied mounting hardware 
(3 places).

13.

14

13

Feed cable thru Control Box 
base.

14. Insert black hole plug in 
bottom of Control base (hole 
plug that was previously 
removed from back of base).
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15.

14

13

15

Snap-on white plastic cap to 
red connector.

16.

16

Insert pin assembly into 
red connector.

17.

17

18

Connect black 
connectors.

18. Connect ribbon cable. 
Ensure that the white cap 
on the red connector and 
the smooth side of the 
black ribbon connector 
are facing up as shown.
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19.

19

Secure Front Panel to the 
base by tightening the 
four mounting screws.

20.

20

To secure the Control 
Box to the wall, draw center 
marks in the two tab slots at 
the rear of the base.

21. Drill two 3/32” pilot holes.

22.

22

With the Control box 
positioned on wall bracket, 
install the two self-tapping 
screws (supplied with wall 
bracket).

Refer to install diagram 
(supplied with wall bracket).
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 11 Networking Support Setup

Networking Support Overview

Networking support within VisionQ and standalone Vision creates a 
convenient mechanism for sharing image data within an office or 
clinic. Using network storage provided and maintained by the 
customer, system software monitors the connection and allows 
scanning to proceed even if the network is temporarily broken. 
Then, the software will automatically update the server with new 
patient scans when the connection is restored.

NOTE: The customer is responsible for providing the network 
accessible storage at their location, including security, backup, and 
archive functions.

Networking Data Flow

When the Image Root Folder is set to a location on the local disk, 
networking software is automatically disabled, and all data 
acquisition goes to the local disk. But if the Image Root Folder is 
setup on a remote network shared folder, acquired data flow is 
altered somewhat and networking software takes part in the flow. In 
this case, VisionQ stores newly-acquired, DICOM-format 
projection data (RAW_CT) and reconstructed images (CT) on its 
local disk (in C:\LocalRoot), regardless of the Image Root Folder 
setting. If a study is immediately viewed or manipulated, that work 
is also saved locally. At the same time, the networking software's 
background Sweeper service automatically tries to copy this new 
data to the designated Image Root Folder.

For VisionQ and standalone Vision, the Study List displayed on the 
left side is derived from the Image Root Folder on the network 
server. Previously-acquired studies are also manipulated from that 
location. Because of this, there is a delay from the time an 
acquisition or reconstruction completes to the time when the study 
is displayed on the Study List. 
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Note that changes made to studies on the network by a standalone 
Vision are not transferred back to the VisionQ local disk.

Network Support Installation/Setup

Provide Network Storage

The customer is required to provide network storage that is 
accessible to the user. To verify proper operation, log in as the 
system operator and use Windows Explorer to navigate to the 
intended networked shared folder, using \\server\folder syntax. 
Create a new text document, enter text into it, save it, and then delete 
it. Do not proceed unless this succeeds.

Install Sweeper Service

1. Double-click the SweeperSetup icon in the 
ProgramFiles\Imaging Sciences International\iCAT Software 
folder to execute the program. A setup wizard is displayed.

2. Click Next on all wizard screens to install the Sweeper service.

3. When complete, click Close on the Installation Complete screen.

If network breaks, VisionQ 
cannot access Study List, but 
can continue to scan patients.

If network breaks, Vision 
cannot access Study List. 

Network must be restored.

VisionQ Vision Standalone

C:\RawData C:\LocalRoot

Sweeper

\\Server\NetRoot
    File server

Image Root Folder
  Dicom, CD,
Received data

  Dicom, CD,
Received data

 Workups, Reports, 
Ancillary Files

 Raw 
projections 
and images

 Workups, Reports, 
Ancillary Files

Image Root Folder



11-3
G990710    30 June 2008
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Configure Sweeper Service

1. Access Control Panel > Administrative Tools > Services and 
double-click Sweeper Service.

2. On General tab, confirm Startup type is set to Automatic. 

3. Click Log On tab: 

a. Click This account radio button.

b. Enter and confirm an account and a password.

NOTE: Be sure to use the same account that was used to log on to the 
computer.
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c. Click OK.

Migrate from Standalone to Server

NOTE: 

• Perform this procedure only if upgrading or migrating from 
an existing standalone setup.

• If the existing network setup shares a portion of the local 
disk of theVisionQ computer, it is still considered 
standalone and this procedure should be followed.

1. Using the Sweeper controller, stop the Sweeper service if it is 
running or paused.

2. Start VisionQ and reconstruct any scans that have not yet been 
reconstructed.

a. Make a note of the standalone Image Root Folder name 
using Tools > Setup. (It is probably C:\DATAFRAMES.) 
Do not change the name at this time.

b. Exit VisionQ.
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Networking Support Setup

3. Using Windows Explorer, navigate to the Image Root Folder 
and delete any files named proj0000.raw, proj0001.raw, ..., 
proj2000.raw.

4. If a folder named bak is present in the Image Root Folder, the 
proj0000.raw files in it, as well as the bak folder itself, can be 
deleted.

5. Check that the folder C:\LocalRoot does not exist. If it does 
exist, check if it is empty. If it is empty, remove it. If it is not 
empty, call Technical Support for help. Continue only when 
C:\LocalRoot does not exist.

6. Using Windows Explorer, change the name of the Image Root 
Folder to C:\LocalRoot.

Change Image Root Folder

1. From VisionQ or standalone Vision, select Tools > Setup.

2. Under DICOM Database Root Folder, enter or browse for the 
Image Root Folder on the network server and click OK. Use 
Universal Naming Convention syntax, such as \\server\NetRoot, 
to identify the network location and not a mapped drive syntax. 

Start the Sweeper

Start the Sweeper service. After 30 seconds, it will start transferring 
any prior scan data to the server. Watch it for a few minutes in case 
there are any network or configuration problems.



11-6

Gendex GXCB-500TM Service Manual

G990710    30 June 2008

Sweeper Service

The Sweeper service starts automatically on system power-up and 
stops on system shutdown. It copies any changed files from the local 
disk (C:\LocalRoot) to the network Image Root (but only if the local 
file is bigger than its network counterpart.) It retries failed transfers 
when the network is up. The Sweeper service will suspend data 
copying and declare itself "Down" if the network disk has less than 
1 GB of free space. It will automatically resume when more space is 
made available by the user.

The Sweeper service periodically cleans the local disk by deleting 
all studies older than 60 days. If there is less than 50 GB of free space 
available on the local drive, the oldest study that is at least 5 days old 
is deleted. Studies that are less than 5 days old are never 
automatically deleted.

Sweeper Controller

The Sweeper controller provides the user interface to the Sweeper 
service and is accessed by clicking the Sweeper icon in the system 
tray. If the controller screen is accidently closed, click Start > All 
Programs > Imaging Sciences > SweeperController.exe to restore 
it. 

Stop Sweeper Pause Sweeper Start Sweeper
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The Status screen allows the user to start/stop and pause/resume the 
Sweeper service. It displays the Sweeper log file C:\Sweeper.log, 
extracts status from the log, and displays it at the bottom of the 
screen. It reduces to a system tray icon showing the Sweeper state 
and a tooltip with the current status.

Network Failures

In the event of a network failure, the best action is to try to quickly 
restore the network. If that is not possible, fallback operations are 
available. 

No Network Access at Startup

When VisionQ or standalone Vision is first launched, it tests 
whether the Image Root Folder is accessible on the network. If it is 
not, the No Network Access dialog is displayed. Fallback operations 
differ for VisionQ and standalone Vision.

Working

Idle

Down

Tooltip shows:
   Time
   Network Status
   # of files in Transfer Queue
   # of files that Failed at Least Once
   # of bytes in Transfer Queue
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Fallback Operations For VisionQ

If there is no network access for VisionQ, the best approach is to fix 
the network. When the network is restored, click Retry on the No 
Network Access screen and continue work as usual.

If network access cannot be quickly restored and scanning must 
continue: 

1. Click Cancel to fallback and use C:\LocalRoot.

2. Scan patients.

3. Exit VisionQ and restore the network as soon as possible. Any 
changes made to studies such as workups, reports, or jpegs will 
be swept to the server when the network connection is restored.

NOTE: Fallback is temporary until VisionQ exits unless the user 
manually changes the setup, which is not recommended.

Fallback Operations For Vision

If there is no network access for standalone Vision, it is essential to 
fix the network because C:\LocalRoot is most likely empty. When 
the network is restored, click Retry on the No Network Access 
screen and continue work as usual.

Network Fails During Operations

If a network failure occurs during use of VisionQ or standalone 
Vision, the following occurs:

• The Study List goes blank (since it comes from the server 
which is no longer accessible.)

• Error messages are displayed in the Sweeper log file.

• The Sweeper icon in the system tray of VisionQ changes to 
the down state and a balloon is displayed for the state 
change. 

NOTE: Be aware that unsaved workups, reports, or jpegs may be lost 
as a result of a network failure.
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Try to restore the network. If the network can be restored, operations 
can continue. If the network cannot be quickly restored and scanning 
must continue, new scans will be safely stored locally, but will not 
be transferred to the server until the connection is restored. 
Therefore, new scans will not appear on the Study list, which will 
remain blank. To see these new scans in the list, exit and follow the 
fallback operations for VisionQ.

Limitations of Networking Support

Known limitations of networking support are:

• There is a network transfer delay between acquisition or 
reconstruction, and the appearance of the study on the Study 
List. Although they may not appear on the list immediately, 
the images are available for review and workup on the 
scanner immediately.

• There is no study locking mechanism to prevent two users 
from simultaneously editing or updating the same study. 
Clinic workflow must ensure this does not happen. 
However, if it does occur, only workups, and not patient 
scan data, are at risk of being lost.

• Unsaved workups, reports, or jpegs may be lost as a result 
of a network failure that happens during the save operation.
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 12 Remote System Import and 
Export

Remote System Import and Export Overview

The VisionQ Remote Service application enables the import of 
patient data from a remote system to Vision Q and enables the export 
of DICOM images to a remote system from VisionQ. This service 
functions to reduce data entry redundancy and to synchronize the 
output generated by VisionQ to a remote system once the study 
acquisition is completed. The Remote Service application is 
available to all VisionQ customers.

Remote System Import 

VisionQ provides two ways to import “scheduled” patient data into 
the system:

• DICOM Worklist - this interface requests and displays 
patient records that match the user-specified criteria from 
the remote DICOM Worklist server.

• Practice Management (PM) - this interface loads and 
displays patient records from an XML file, generated by the 
PM server.

Users can choose which of the two interfaces is suitable for their 
workflow and set up the interface accordingly.

When the VisionQ user selects to import data, the PDI service class 
user (PDI.dll) issues a DICOM C-FIND request to pull patient 
records from the remote system. All VisionQ “scheduled” patient 
records are sent from the Worklist or PM system to VisionQ.
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Import Installation and Setup

If the PDI.dll has not been installed, place the PDI.dll in the same 
folder where the VisionQ.exe resides. The PDI.dll must be in place 
before setup can continue.

Determine which interface type, DICOM Worklist or PM, is to be 
used for import, and follow the appropriate setup procedure below.

Set Up DICOM Worklist Interface

1. Start VisionQ.

2. From the VisionQ Main menu, select File > New Patient.

PDI Service 
Class User

VisionQ

(1) “Process”
     command 
     issued

(2) Request issued
(3) Request received

(4) Patient data sent
(5) Response received

Remote
 Server
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3. Click Import. The Patient Importer screen is displayed.

4. Click Config.

5. Enter Station name, IP Address, AE Title, and Port number for 
the remote server from where files are to be imported.

6. Click Save, and then Close.

7. Click Cancel on Patient Importer to close window.



12-4

Gendex GXCB-500TM Service Manual

G990710    30 June 2008

NOTE: The Options button on the Patient Importer window enables 
setting of the date format and the AE title for the local Acquisition 
computer, and enabling auto process. These settings are optional and 
do not have to be changed.

Set Up Practice Management Interface

1. Start VisionQ.

2. From the VisionQ Main menu, select File > New Patient.

3. Click Import. The Patient Importer screen is displayed.

4. Click the PM tab.

5. Click Browse and browse to the PM Interchange location. This 
is the location where an XML file, generated by the PM server, 
is saved.

6. Click Cancel on Patient Importer to close window.
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Import Patient Data

1. From the VisionQ Main menu, select File > New Patient.

2. Click Import.

3. On the Patient Importer screen, click Process. Patient data is 
retrieved from the remote system and listed at the bottom of the 
screen.

4. Select (highlight) a patient on the list and click Import.

5. The Acquisition screen is displayed for the selected patient.
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Remote System Export 

VisionQ enables DICOM images to be transferred from the VisionQ 
to a remote system, such as a Picture Archive and Communications 
System (PACS). The Remote Service Send Module (RSSM) enables 
the transfer using DICOM storage protocol (C-STORE). RSSM 
continuously monitors the local folder that is setup to receive the   
images to be exported. When DICOM images are exported to the 
folder, RSSM transfers them to the user-defined remote destination.

Export Installation and Setup

1. Place the RSSM.exe in the same folder where the VisionQ.exe 
resides.

RSSM

VisionQ

(2) “Send to Remote”
      command issued

(3) DICOM files
      saved to disk

(4) DICOM files
     transferred to 
     remote system

(1) Continuous 
      monitoring
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2. Double-click RSSM.exe. The DICOM Send Module is 
displayed.

3. Click Options.

4.  Click Browse in Source image folder section and browse to the 
folder where the DICOM files are to be placed for export. Create 
a new folder if desired.

5. In Remote Server section:

a.  Enter Station name, IP Address, AE Title, and Port number  
for remote DICOM server (C-STORE SCP).
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b. Click Save.

c. Click Test to perform DICOM validation (C-ECHO) to 
check whether the remote server is accessible.

6.  Click Browse in the Log file folder section and browse to the 
folder where the RSSM log file is to reside.

7. In the Miscellaneous section:

a. Enter Local AE Title for the VisionQ system.

b. If DICOM server supports Perform Storage Commitment 
feature, this option can be selected, if desired. Otherwise, 
leave unchecked.

c. If transmission should begin automatically whenever RSSM 
is started, select Auto Send when launched. Otherwise, 
leave unchecked.

8. Click OK.

9. Click Close on the DICOM Send Module.

RSSM Log

While RSSM is transferring data to the remote 
system, an icon is displayed in the system tray. 
Right-click the icon and select View Log to 
display the log.

The log shows the status of each transferred file.
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The log can also be accessed by selecting Show. This displays the 
DICOM Send Module with the following options:

• Options - Used to set date format.

• View Log - Displays RSSM log.

• Clear Log - Clears RSSM log of all previous activity.

• Clear Queue - Clears the queue of all studies. A study is 
queued when RSSM has exhausted all attempts to transmit 
the study.

• Start/Stop - Toggles to either start or stop RSSM.

• Close - Closes the DICOM Send Module window.

Send Patient Data to a Remote System

1. With a Patient selected in the Study List, right-click on the scan 
to be sent and select Send to Remote.

2. A dialog is displayed 
and the dataset is 
transferred.

3. If a previous export session has not been successfully 
transferred, a warning is displayed.



12-10

Gendex GXCB-500TM Service Manual

G990710    30 June 2008

4. Check the RSSM log to determine status of the last transmitted 
file. If file did not transfer successfully, investigate the cause, 
such as a network failure to the remote system and correct the 
problem.

If the file no longer needs to be transferred, click Yes to 
overwrite the previous session.

If the file needs to be sent, click No to cancel and wait for 
previous file to transfer.
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 13 Product Information

Technical Specifications

X-ray Source
Tube Voltage: 120 kVp (eff)
Tube Current: 3-7 mA
Voltage Wave Shape: Constant Potential
Focal Spot: 0.0197 inches (0.5 mm)
Duty Cycle: 15%
Source to Sensor distance: 28.1 inches (71.4 cm)

Source to Patient distance*:19.5 inches (49.53 cm) (center of rotation)

* The patient must be properly positioned in the Head Support 
Positioner Mechanism for each patient for all applications in order 
to have the focal spot to skin distance as large as possible.

Minimum Filtration (at 120 kVp(eff)) (mm of aluminum equivalent): 
10 mm or greater

Maximum Rated Continuous Tube Operation:130 kVp @ 0.5 mA

Maximum Rated Pulsed Tube Operation: 130 kVp @ 1mA

NOTE: Leakage technique factors are measured at the maximum specified 
energy.

Maximum Deviation: kV: + 5 kV

mA: + 10%

Timer: ± 5%

X-ray Beam Size: 13 cm height x 13 cm wide

PAN: 1 cm width x 13 cm height
            (Automatically collimated not to exceed image detector readable area)

Image Detector: 12.8 cm width x 12.8 cm height)

Sensor Front Panel Attenuation Value: Less than 1mm of aluminum 
equivalent
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Gray Scale: 14 bit

Voxel Size: 0.4/0.3/0.25/0.2/.125 mm

Image Acquisition: Single 360 degree rotation (maximum)

Scan Time: 23.0/8.9 seconds

Field of View: (standard) 8 cm x 8 cm

Extended Field of View: (EDS) 14 cm diameter x 8 cm height

Note: Maximum values can be collimated down.

Primary Reconstruction: Less than 2 minutes for 23.0 second scan @ 
0.4 voxel

Secondary Reconstruction: Real Time

Stopping Distance and Angle: Hard stop is at -45o and 470o (reference is 
the gantry at the home position being 0o). Platform travel is 69 mm.

Power Requirements

The Scanner requires a Dedicated Line. A Surge Protector is recommended. 
The Scanner is suitable for continuous connection to a power supply in 
stand-by mode.

Line Voltage: 100VAC, 115VAC, 200VAC or 230VAC (Factory Set)

Line Voltage Regulation requirement: + 10%

Line Current: 15 Amps (100V), 10 Amps (115V), 7.5 Amps (200V) or 5 
Amps (230V)

Line Frequency: 50 Hz / 60 Hz

Phase: Single

Main Circuit Breaker: 15 Amps (100V), 10 Amps (115V), 7.5 Amps 
(200V), or 5 Amps (230V)

Apparent Resistance of Supply Mains

For the purpose of obtaining the apparent resistance of supply mains, 
resistance is determined according to the following formula:
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Weight
Total Weight: 510 lbs. (231.3 kg)

Tube Head Pod: 35.5 lbs. (16.1 kg)

Receptor Pod: 57 lbs. (25.9 kg)

X-Ray Power Supply: 9 lbs. (4.1 kg)

Power Cords required outside of the United States

Power Cords are not supplied with systems used outside of the United 
States. Three Power Cords must be obtained, one each for the Scanner, 
Computer, and Monitor. The use of medical grade line cords is 
recommended.

WARNINGWARNING
Splicing terminating connectors onto the power cord is not 
recommended and may result in a hazardous condition.

Power Cord Specifications: 
10 Amp, 220-240VAC, 50 Hz / 60 Hz, 16/3 Gauge (minimum) Length 
6 to 12 ft. (2m to 4m), IEC-320-C13 connector end. Both the plug and 
connector ends must be molded with power cord.

Circuit Breaker 
Assembly

U0 U1 I1 Apparent 
Ressistance

100VAC 101.9VAC 98.1VAC 7.03A 0.54ohms

115VAC 115.1VAC 111.2VAC 6.10A 0.64ohms

200VAC 200.5VAC 191.1VAC 3.69A 2.55ohms

230VAC 230.9VAC 218.7VAC 3.18A 3.84ohms

Where:
U0 is the no-load Mains Voltage
U1 is the Mains Voltage under load.
I1 is the Mains Current under load.

U0 - U1
R = 

I1
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Environmental Specifications

Operating

50 to 95 degrees Fahrenheit

(10 to 35 degrees Celsius)

10% to 90% Relative Humidity, non-condensing

Transportation and Storage

-4 to 158 degrees Fahrenheit

(-20 to 70 degrees Celsius) 

10% to 90% Relative Humidity, non-condensing

Acquisition Computer

Acquisition Computer requires a Dedicated Line and a Surge Protector is 
recommended.

Tower Computer Dimensions: 
17"h x 18”d x 8.5”w (43cm x 47cm x 22cm)

Monitor with Stand Dimensions: 
20” (51cm) LCD Monitor 17.5"h x 13.5”w (45cm x 34cm)

Keyboard Dimensions: 
17”w x 7”d (43cm x 18cm)

Minimum Specifications for Acquisition Computer Provided with 
the System:

• Pentium-4 Processor, 3.8 GHz minimum
• Windows XP Professional w/SP2
• 120 GB Hard drive 
• 2 GB RAM
• 20” (51cm) Flat Panel Display
• Video Memory of 128MB minimum
• 2 Network Interface Cards (Ethernet)
• 1 serial port, 9-pin
• 3 USB ports
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Patient Support Chair

Overall dimensions: 
28.5"d x 24”w x 43”h (72.4 cm x 61 cm x 109.2 cm)

Weight: 125 lbs (56.7 kg)

Seat height adjustment: 14” to 29” (35.65 cm to 73.7 cm)

Maximum patient weight: 400 lbs (181 kg)

Complies with IEC 60601-2-32:1994

Disposal

Follow local regulations on disposal of waste parts. The X-ray 
source assembly, image sensor and all electronic circuits should be 
regarded as non environmental friendly waste product. The system 
does not generate, or require the use of, any materials that require 
special disposal instructions as part of regular operation.

Extension Cords

Do not use any extension cords which are not provided with the 
system. Be aware that multiple portable socket outlets or extension 
cords are not to be connected to the system.

External Item

Do not connect any items or equipment to this system which are not 
part of the system. 

Cleaning

Routinely clean and disinfect all items which come in contact with 
the patient. Use Biocide ® from Biotrol International or equivalent 
cleaner and disinfectant. Biocide® is an Iodophor formulation that 
kills HIV, Tuberculosis and Polio in 10 minutes.
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Electromagnetic or other Interference 
(Emissions and Immunity)

The System was tested and found to comply with the limits for Class 
B equipment, pursuant to IEC 60601-1-2. These limits are designed 
to provide reasonable protection against harmful interference in a 
commercial environment. The system generates, uses, and can 
radiate electromagnetic energy and if not installed and used in 
accordance with these instructions, may cause harmful interference 
to surrounding equipment. Also portable and mobile RF 
communications equipment can effect the operation of the system. 
Proper precautions and equipment location should be observed, 
refer to the following table:

The System is intended for use in an electromagnetic environment specified below. The 
Customer or User should ensure that the system is used in such an environment.

Immunity Test Compliance Level Electrostatic Environment - Guidance
IEC 61000-4-2
Electrostatic 
Discharge (ESD)

+6 kV Contact
+8 kV Air

Floors should be wood, concrete or ceramic tile. If 
floors are synthetic, the relative humidity should be 
at least 30%

EFT
IEC 61000-4-4

+2 kV Mains
+1 kV I/Os

Mains power quality should be that of a typical 
commercial or hospital environment.

Surge
IEC 61000-4-5

+1 kV Differential
+2 kV Common

Mains power quality should be that of a typical 
commercial or hospital environment.

Voltage Dips/
Dropout
IEC 61000-4-11

>95% Dip for 0.5 cycle
60% Dip for 5 cycles
30% Dip for 25 cycles
>95% Dip for 5 
seconds

Mains power quality should be that of a typical 
commercial or hospital environment. If the user 
requires continued operation during power mains 
interruptions, it is recommended that the system be 
powered from an uninterruptible power supply.

Power Frequency 
50/60 Hz 
Magnetic Field 
IEC 61000-4-8

3A/m Power frequency magnetic fields should be that of 
a typical commercial or hospital environment.

Conducted RF
IEC 610000-4-6

3 Vms 150 kHz to 80 
MHz

Portable and mobile communication equipment 
should be separated from the system by no less 
than 19 feet (6 meters).
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If the System does cause harmful interference to surrounding 
equipment which can be determined by turning the system OFF and 
ON, the customer or user is encouraged to try to correct the 
interference by one or more of the following methods:

• Increase separation between the system and surrounding 
equipment.

• Connect the System into an outlet on a circuit different from 
that to which the surrounding equipment is connected.

• Consult Imaging Sciences International, the dealer or an 
experienced technician for help.

Emission Test Compliance Electrostatic Environment - Guidance
Radiated RF
IEC 61000-4-3

This Scanning System is intended for use in an 
electromagnetic environment in which radiated 
disturbances are controlled. The customer or user 
of the system can help prevent electromagnetic 
interference by maintaining a minimum distance 
between portable and mobile RF communications 
equipment and the system as recommended 
below, according to the maximum output power of 
the communications equipment.

Maximum 
Output Power 

(Watts)

Separation
150 kHz to 800 

MHz

Separation
800 MHz to 2.5 

GHz
0.01 15 in (38 cm) 30 in (76 cm)
0.1 15 in (38 cm) 30 in (76 cm)
1 46 in (117 cm) 8 ft (2.4 m)

10 12 ft (3.7 m) 24 ft (7.3 m)
100 38 ft (11.7 m) 77 ft (23.4 m)

Note: Field strengths from transmitters, as 
determined by an electromagnetic site survey, 
should be less than the compliance level of 3 V/m. 

RF Emissions 
CISPR 11 Group 1

The system uses RF energy only for its internal 
function. Therefore, its RF emissions are very low 
and are not likely to cause any interference in 
nearby electronic equipment.

RF Emissions 
CISPR 11 Class B

The system is suitable for use in all establishments, 
including domestic, and those directly connected to 
the public low - voltage power supply network that 
supplies buildings for domestic purposes.

Harmonics 
IEC 61000-3-2 Class A
Flicker 
IEC 61000-3-3 Complies

The System is intended for use in an electromagnetic environment specified below. The 
Customer or User should ensure that the system is used in such an environment.
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Use only the interface cables provided with the System. Using other 
interface cables may exceed the limits of Class B equipment, 
pursuant to IEC 60601-1-2.

Equipment Standards

The System was tested and/or evaluated against and found 
compliant to the following standards/requirements:

UL 60601-1 IEC/EN 60601-1-4

CSA C22.2 No. 601.1 IEC/EN 60601-2-32

JIS Z4701 IEC/EN 60825-1JIS T0601

JIS Z4703 CE-MDD 93/42/EEC

JIS T0601 LVFS 2003:11 (Swedish regulation, 
transposing the MDD 93/42/EEC) 

IEC/EN 60601-1 CMDCAS (Canadian Medical Device 
Regulation)

IEC/EN 60601-1-1 ISO 10993-1:2003

IEC/EN 60601-1-2 ISO 14971:2000

IEC/EN 60601-1-3

Equipment Class

Protection against electric shock: Class I

Applied part has degree of protection against electric shock: Class B

Class of equipment against ingress of liquids: Ordinary Equipment, 
IPX0

Radiated emissions: Class B
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Preventive Maintenance Schedule - for Owner / User

Daily: Routine Dusting - all surfaces

Monthly: Clean all surfaces and check for failed/faulty indicator 
lights.

Yearly: Check for satisfactory image quality.

IT IS THE RESPONSIBILITY OF THE USER TO INSURE THAT 
THE EQUIPMENT IS MAINTAINED IN COMPLIANCE WITH 
THE MANUFACTURER'S RECOMMENDED MAINTENANCE 
SCHEDULE. THE MANUFACTURER AND THE ASSEMBLER 
/ INSTALLER ARE RELIEVED FROM RESPONSIBILITY IN 
THOSE CASES WHERE NON-COMPLIANCE WITH THE 
STANDARD RESULTS FROM THE USER'S FAILURE TO 
HAVE THE MANUFACTURER'S RECOMMENDED 
MAINTENANCE PERFORMED.

The actual maintenance inspection and consequent service must be 
accomplished either by an authorized dealer or by a competent 
serviceman of the user's choice who has adequate training in those 
aspects of the Performance Standards of the Radiation Control for 
Health and Safety Act of 1968 that are applicable to this equipment.

Neither the inspection nor service is part of the equipment warranty. 
(To be arranged for by the Owner or User with the Dealer's Service 
Department).

Planned Maintenance - 12 Month Schedule

The Planned Maintenance philosophy for this system is based upon 
the assumption that a periodic inspection of the equipment, along 
with periodic cleaning and calibration, will maintain image quality.

The system requires normal periodic inspection and maintenance. 
Scheduled periodic inspections are necessary to detect problems 
which can result from excessive wear, loose items, chafing wires, 
and mis-adjusted parts from continual system use.

In addition to mechanical inspection and calibration, a series of 
image performance tests are to be conducted. These tests verify that 
the system meets or exceeds operational specifications and that it 
will provide continued excellent image quality.

Planned maintenance is to be performed annually by a factory 
trained Service Representative.
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Cleaning

Cleaning the equipment frequently, especially if corroding 
chemicals are present is a function of the Operator. Unless otherwise 
instructed, use a cloth moistened with warm water and mild soap. Do 
not use strong cleaners and solvents as these may damage the finish.

Be careful when cleaning to avoid liquid leaking inside the Gantry.

WARNING
USE EXTREME CARE WHEN WORKING INSIDE THE 
SYSTEM. VOLTAGES ARE PRESENT WHEN THE SYSTEM 
COVERS ARE OFF. ACCIDENTAL CONTACT WITH THESE 
VOLTAGES MAY CAUSE SERIOUS INJURY OR DEATH.

Planned Maintenance Checklist

Perform Calibrations

Panel Calibration

Collimator Calibration

Geometry Calibration

Check Detector Pivot (displayed under Geometry, both Portrait and Landscape)

Ensure Detector Pivot is between -0.10 & 0.10. If measurements are not within 
tolerance, call Service to have Receptor Panel leveled.

Peform QA Water Phantom Tests

Noise Level Test (Landscape Mode)

Uniformity Test (Landscape Mode)

Noise Level Test (Portrait Mode)

Uniformity Test (Portrait Mode)

PAN Phantom Test

Radiation Ouput Test (performed by qualitfied Physicist)

Check Chair Alignments

Check Chair Center Alignment (using Chair Center Locator)

Check Chair Level (using Chair Center Locator)
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Check Laser Alignments

Check Centerline Alignment (using Chair Center Locator)

Check Crosshair Laser (align with notches on Receptor Panel Cover)

Inspect Tube Housing Components

Certification Label

Warning and Indicators

Oil Leaks

Physical Damage

Mounting System Stability

Inspect Beam Limiting Device

Physical Damage

Certification Label

Check/Inspect X-Ray Controller

Visual Warning Indicator

Audible Exposure Signal

Certification Label
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 Replaceable Parts - Reference List

There are no equipment parts designated as repairable in the field by 
the owner/user of the equipment. Contact Service if repairs are 
needed. The following is a list of replacement parts.

Sub Assembly Number Description
11-0 Rotation Stepper Motor
27-0 Head Rest, Carbon Fiber
35-0

1000-0
Tube Head Assembly and
X-ray Power Supply Assembly (sold together)

102-16 Platform Motor
109-2 Receptor Motor
137-0 Beam Limiter Assembly
1203 System PCB
1210 Motherboard
1255 Circuit Breaker, 10A for 115 Volt Systems
1256 Circuit Breaker, 5A for 230 Volt Systems
1257 Circuit Breaker, 7A for 200 Volt Systems
1258 Circuit Breaker, 15A for 100 Volt Systems

G1304-0 Patient E-stop Box
G1305 Patient Alignment Panel

G1306-0 Operator Control Box
1539 Laser, Cross
1540 Laser, Straight Line

800130 Computer & Keyboard
800145 Monitor, LCD
800170 Receptor Panel
800550 Acquisition Key, Cobra
1000005 Fuse, 2.5A, 3AG, Sow Blow
1000010 Fuse, 10A, 250 VAC
1000011 Fuse, 0.25A, 250 VAC, Slow Blow
1000028 Chair, Linear Actuator
1000032 24VDC Power Supply (Silver Box)
1000111 Power Supply (15 VDC)
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Accessories
Patient E-stop
Part # 1304-0
Quantity 1

Carbon Fiber Head Rest
Part # 27-0
Quantity 1

Glide
Part # 1000179
Quantity 4

Head Restraint Band
Part # 27-1
Quantity 100

Pan Phantom
Part # 12-0
Quantity 1

Velcro Head Restraint 
Kit
Part # 903-0
Quantity 1

Booster Seat
Part # 1000196
Quantity 1

Phantom Assembly
Part # 17-01-0
Quantity 1

Foot Stool
Part # 1000197
Quantity 1

Tool Kit
Part # 5-0
Quantity 1

Chair Patch Cable
Part # 1520
Quantity 1

QA Phantom
Part # 13-20
Quantity 1

Cable Clips
Part # 101-6
Quantity 6

Water Phantom Jar
Part # 1000267
Quantity 1
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Chair Center Locator
Part # 26-16 
Quantity 1

Bite Tip Holder
Part # 9140-0326-0004
Quantity 2

Platform Assembly
Part # 14-4-0
Quantity 1

Chin Rest
Part # 26-12
Quantity 1

Bite Tip
Part #  26-15
Quantity 25

Chin Cup
Part # 9140-0026-0006
Quantity 1

Surge Suppressor
Part # 98028
Quantity 1

Power Cord
Part # 1000117
Quantity 1

Chin Rest Slide, 
Straignt
Part # 160-1
Quantity 1

Chin Rest Clamp Block 
Assembly
Part # 160-2-0
Quantity 1

Chin Rest Slide, 
Bent
Part # 160-2
Quantity 1

Hole Plug - Ricko
Part # 1000261
Quantity 4
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Position Alignment 
Tool
Part # 33-19
Quantity 1

PAN Head Holder
Part # 33-0
Quantity 1

Foam Disk
Part # 1000323
Quantity 1

Operators’ Manual
Part # G990700
Quantity 1 (Softcopy)
Optional hardcopy

Part # 90-0

Door Interlock Cable
Part # 1524
Quantity 1

E-net Cable 50
Part # 1000116
Quantity 1

Warning Cable
Part # 1527
Quantity 1

Control Box
Part # 1306-0
Quantity 1
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System Gantry Dimensions

SIDE VIEW

TOP VIEW

FRONT VIEW
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Chapter

 14 Illustrated Parts Breakdown

WARNINGWARNING
High voltage is present in the device. Remove power from device 
before removing covers or cables. To avoid personal injury from 
electrical shock, do not operate the system with any covers open or 
cables removed.

This chapter is used to provided replacement part numbers. Ensure 
power is removed before servicing the device.

The following Assemlies are illustrated.

• System Assembly

• Overhead Assembly

• Chair Assembly

• Upper Chair Assembly

• Upper Chair Assembly Parts List

• X-Ray Source Assembly

• Receptor Panel Assembly
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System Assembly Parts List

Item Part Number Description

1 G150-4 Upper Cover

2 BHCS #8-32 x 3/8 Long

3 G32-0 Wall Stabilizer (not shown)

4 G138-0 Flip Receptor Assembly

5 G101-7 Rear Scatter Shield

6 G20-0 Chair Assembly

7 1000031 IEC #IL8-6B x 3 HX-BC Bottom Chamfer

8 G504-0 Lower Plate Weldment

9 1000108 IEC #IL8-6B x 2 HX-BC Bottom Chamfer

10 G140-0 X-Ray Source Assembly

11 15-0 Laser Line Assembly

12 G150-3 Lower Cover Assembly

13

14    1302 Resident Indicator Panel
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Overhead Assembly
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Overhead Assembly Parts List

Item Part Number Description
1 1000032 24V Power Supply
2 102-8 24 Volt Power Supply Strap
3 #10-32 Nut
4 1000111 24V Receptor Power Supply
5 102-15 Receptor Power Supply Strap
6 #10-32 Nut
7 1507 Limit Switches (set)
8 10-0 Spindle Assembly
9 11-0 Rotation Drive

10 1000105 Netgear Ethernet Switch
11 102-6 Ethernet Switch Strap
12 1701-0 Toroid Isolation Transfromer
13 SHCS 5/16-18 x 1 Long
14 1015-0-1 Power Bracket Assembly
15    1000176 Buss #HTB-84M
16    1000010 10A Fuse Digi-Key #F985-ND
17    1000005 2.5A Fuse Digi-Key #F979-ND
18    1000011 1/4 A Fuse Digi-Key #F939-ND
19    1255 115V Circuit Breaker
20    1310 Fuse Lable (not shown)
21    1570  Line Choke
22 102-16 Stepper Motor Assembly - 17 Frame
23 1000038 B & B Electronics
24 1203 i-CAT System Board
25 1210 i-CAT Computer Board
26 1526 Warning System External Cable Assembly
27 1523 Door Interlock External Cable Assembly
28 1519 Control Box External Cable Assembly
29 1521 Chair External Cable Assembly
30 1000-0 X-Ray Power Supply
31 1541 Overhead Fan (pair)
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Rotation Drive Assembly
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Rotation Drive Assembly Parts List

Item Part Number Description

1 SHCS #10-24 x 5/8 Long

2 Split Washer #10

3 11-5 Drive Gear

4 11-3 Gear Encoder Disk

5 11-4 Gear Clamp

6 11-2 Rotation Motor Bracket

7 1000027 McMaster #92510A602

8 1205 Gear Encoder

9 Split Washer #6

10 SHCS #6-32 x 1/2 Long

11 11-6 Stepper Motor

12 120110 Thomson Micron #NTR23-025

13 Split Washer #10

14 SHCS #10-24 x 1/2 Long

15 SHCS #10-24 x 1 Long
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X-Ray Source Assembly
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X-Ray Source Assembly Parts List

Item Part Number Description

1 G140-7 Rear X-Ray Source Cover

2 BHCS #8-32 x 1/2 Long

3 SHCS 1/4-20 X 1 Long

4 Split Washer 1/4

5 35-0 Tube Head

6 1539 Cross Laser Assembly

7 106-4 Cross Laser Mirror

8 BHCS #6-32 x 1/4 Long

9 Split Washer #10

10 SHCS #10-24 x 3/8 Long

11 137-0 Beam Limiter

12 G1305 Patient Alignment Panel

13 G140-2 Front X-Ray Source Cover Assembly

14 1308-0 Beam Limiter Panel

15 1206 Beam Limiter Control PCB

16 1000211 #6-32 x 1/2 Long Standoff McMaster #91

17 106-8 Beam Limiter Board Shield

18 Split Washer #6

19 SHCS #6-32 x 1/4 Long
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Receptor Panel Assembly
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Receptor Panel Assembly Parts List

Item Part Number Description

1 G138-20 Rear Cover

2 BHCS #8-32 x 1/2

3 1000237 Camera Card Pleora #PT1000-Cl4-E

4 SHCS #6-32 x 3/8 Long

5 Split Washer #6

6 Flat Washer #6

7 138-3 Shift Motor

8 SHCS M3 x 8mm Long

9 Split Washer M3

10 Nut #8-32 (shift motor)

11 1000259 Spring McMaster #94135K13

12 138-11 Plunger

13 310243 Century Spring #70602

14 SHCS #10-32 x 5/8 Long

15 Split Washer #10

16 138-10 Plunger Block

17 1000188 McMaster # 8511A24

18 Shoulder Screw 1/4 Diameter x 1 1/4 Long x #10-32

19 1000257 Century Spring #71126

20 1550 Flip Receptor Limit Switch

21 SHCS #4-40 x 3/4 Long

22 Split Washer #4

23 G138-18 Panel Cover

24 800170 1313 Receptor

25 SHCS M5 x 10mm

26 Split Washer M5

27 BHCS 3/8-16 x 3/4

28 240361 Dual Vee #W2

29 Shim Washer 3/8 ID x .02 Thick
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Chair Assembly
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Chair Assembly Parts List

Item Part Number Description
1 1020-0 Chair Receptacle Plate Assembly
2    1204 Patient Alignment Board
3    1516 Patient E-Stop External Cable
4    1547 Wheel Chair External Cable
5    1522 Chair Junction Cable
6 SHCS 1/4-20 x 5/8 Long
7 1/4 Split Washer
8 505-5 Rail
9 25-2 Back Plate

10 SHCS #6-32 x 1 Long
11 #6 Split Washer
12 1548 Wheel Chair Switch
13 1000029 McMASTER # 97245A688
14 1000028 MAGNETIC #ECO50-025MM1B0-000
15 23-1 Wheel
16 23-2 Wheel Axle
17 SHCS 1/4-20 x 1/2 Long
18 1/4 Split Washer
19 508-0 Actuator Plate
20 23-3 Receptacle Flange
21 21-0 Seat Assembly
22    1309-3 Chair Installation Label
23    980317 Office Star #CT12 Characoal Vinyl A Grade
24    21-2 Seat Frame
25    21-1 Seat Standoff
26 M6 Split Washer
27 SHCS M6 x 46mm Long
28 980316 Office Star #CT11 Characoal Vinyl A Grade
29 23-6 Back Rest Adapter
30 1/4 Split Washer
31 SHCS M6 x 20mm Long
32 23-5 Seat Back Support
33 SHCS 1/.4-20 x 1/2 Long
34 1309-2 Chair Warning Label 2
35 1309-1 Chair Warning Label 1
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Upper Chair Assembly
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Upper Chair Assembly Parts List
Item Part Number Description

1 22-4 Clamp Knob
2 22-2 Support Plate
3 Nylon Flat Washer 5/16 ID - 3/4 OD
4 22-3 Clamp Plate
5 SS 5/16-18 x 1.25 Long
6 SHCS 1/4 - 20 x 5/8 Long
7 Flat Washer 1/4
8 22-1 Slider Block
9 SHCS #8-32 x 1/2 Long

10 22-10 Roller Plate
11 Flat Head 1/4-20 x 1/2 Long
12 22-5 Left Cap Plate
13 22-6 Right Cap Plate
14 Split Washer 1/4
15 SHCS 1/4-20 x 5/8 Long
16 24036 Dual-Vee #W1
17 Split Washer #10
18 SHCS #10-32 x 5/8 Long
19 SHCS 1/4-20 x 1 1/4 Long
20 Split Washer 1/4
21 Flat Washer 1/4
22 24-1 Hinge Bar
23 1000045 Bunting #BM4071
24 24-4 Tee Nut
25 24-3 Magnet Plate
26 SHCS #10-24 x 1/4 Long
27 1314 Gate Label
28 26-11 Upper Guide
29 BHCS #6-32 x 1/4 Long
30 26-10 Lower Guide
31 SHCS #6-32 x 1/2 Long
32 1000181 3/8 Spring Plunger McMaster Carr #8499A85
33 SHCS 1/4-20 x 5/8 Long
34 26-9 Slide Block
35 Dowel Pin 1/4 x 1 Long
36 24-2 Gate
37 24-6 Gate Pivot Pin
38 26-4 Thumb Screw
39 26-3 Clamp Button
40 26-1 Chin Rest Guide
41 Shoulder Screw 1/8 Diameter x 5/16 Long x #4-40
42 310242 Century Spring #70464
43 26-2 Bite Tip Clamp Button
44 22-8 Glide
45 SHCS #10-32 x 3/4 Long
46 22-11 Clamp Handle
47 Bronze Bushing .375 ID x .625 OD x .50 Long
48 22-12 Clamp Washer
49 22-9 Lock Shaft
50 1000047 J.W. Winko #6TCC3/E
51 22-7 Arm
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Chapter

 15 Radiation Environment 
Survey

The direct and scattered beams can produce serious bodily injuries 
to Patients and persons in the surrounding area. Adequate 
precautions must always be taken to avoid or reduce exposure to the 
useful beam, as well as scattered radiation. Refer to the following 
figure and related table to determine scattered beam measurements.

3 Feet

270o

90o

0o

315o

180o

135o

45o

225o

6 Feet
9 Feet

3 Feet Above

3 Feet Above
+ 3 Feet Outward
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Conditions of Operation – 8.9 and 23.0 Second Scans

The measurements were conducted by a certified health physicist from RayScan, 
Inc, on the factory floor on 04.01.08.  He was assisted by a physicist, employed by 
the manufacturer.

The X-ray scatter was measured from a GXCB-500 Scanner in several modes, 
using a Radcal Model 9010 Radiation monitor, with a 10X5-180 chamber.

A head phantom from Phantom Labs, Inc, was used as the scatter center and 
placed in a representative location as measured by an image scan. Model SK150 
has real bone as the structural component and proprietary Urethane filler that 
simulates the response of tissue.

The radiation monitor was held at the same height as the phantom head’s nose and 
the distances were measured from the center of rotation of the CT scan.  
Measurements were taken every 45°, with 0° measured directly in front of the 
scanner, and at distances of 3ft, 6ft, and 9ft.  In addition the scatter was measured 
at 3ft directly above the system and at a position 3ft above and 3ft directly in front 
of the device.

Scatter was measured for the Standard (full-beam), Extended Diameter Scan 
(EDS) (half-beam), and Panoramic mode.  Both scan modes were taken with 0.4 
mm Voxels for a scan time of 8.9s. The X-ray beam details were 120 kVp, 5 mA, 
and 28.52 mAs.  The Panoramic scan settings were measured with the Large 
exposure setting with the following settings: 89kVp, 5 mA, and 71.43 mAs, 20s 
scan time.
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Scatter Measurements for 8.9 Second Scans
8.9 second scan using pulsed X-ray: 309 frames, 19 ms pulse width at 5 mA. Based 
on this, the estimated workload is:

10 scans per week yielding a workload of 4.8 mA-min/week
25 scans per week yielding a workload of 11.9 mA-min/week
50 scans per week yielding a workload of 27.8 mA-min/week

Standard (full-beam) Diameter 8.5 - Height 8.5 cm
NOTE: Selectable voxel sizes are 0.4 and 0.3.

Location

Distance in 
Feet

[meter]
Exposure 

(mR)
Exposure 

(μR)
Exposure
μR/mAs

10
scans/wk 

mR/wk

25
scans/wk 

mR/wk

50
scans/wk 

mR/wk

0o
3 [0.91m] 0.34 344 12.06 3.4 8.6 17.2

6 [1.82m] 0.08 82.5 2.89 0.8 2.1 4.1

9 [2.74m] 0.04 38.2 1.34 0.4 1.0 1.9

45o
3 [0.91m] 0.35 349 12.24 3.5 8.7 17.5

6 [1.82m] 0.08 81.4 2.85 0.8 2.0 4.1

9 [2.74m] 0.04 37.6 1.32 0.4 0.9 1.9

90o
3 [0.91m] 0.25 250.9 8.80 2.5 6.3 12.5

6 [1.82m] 0.06 63.6 2.23 0.6 1.6 3.2

9 [2.74m] 0.03 29.4 1.03 0.3 0.7 1.5

135o
3 [0.91m] 0.05 54.1 1.90 0.5 1.4 2.7

6 [1.82m] 0.02 16.4 0.58 0.2 0.4 0.8

9 [2.74m] 0.01 8.2 0.29 0.1 0.2 0.4

180o
3 [0.91m] 0.05 49.9 1.75 0.5 1.2 2.5

6 [1.82m] 0.02 15.7 0.55 0.2 0.4 0.8

9 [2.74m] 0.01 6.8 0.24 0.1 0.2 0.3

225o
3 [0.91m] 0.05 51.4 1.80 0.5 1.3 2.6

6 [1.82m] 0.02 15.1 0.53 0.2 0.4 0.8

9 [2.74m] 0.01 8.2 0.29 0.1 0.2 0.4

270o
3 [0.91m] 0.26 257.7 9.04 2.6 6.4 12.9

6 [1.82m] 0.06 63.1 2.21 0.6 1.6 3.2

9 [2.74m] 0.03 29.5 1.03 0.3 0.7 1.5

315o
3 [0.91m] 0.32 319 11.19 3.2 8.0 16.0

6 [1.82m] 0.08 78 2.73 0.8 2.0 3.9

9 [2.74m] 0.04 36.3 1.27 0.4 0.9 1.8
3 Feet above 0.04 37.7 1.32 0.4 0.9 1.9

3 Feet above + 3 Outward 0.12 123.8 4.34 1.2 3.1 6.2
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Radiation Scatter Field for Standard (full-beam) - 8.9 Second  Scan
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Half Beam Diameter 14 - Height 8.5 cm

NOTE: Selectable voxel sizes are 0.4 and 0.3.

Location

Distance in 
Feet

[meter]
Exposure 

(mR)
Exposure 

(μR)
Exposure
μR/mAs

10
scans/wk 

mR/wk

25
scans/wk 

mR/wk

50
scans/wk 

mR/wk

0o
3 [0.91m] 0.285 285.1 10.0 2.9 7.1 14.3

6 [1.82m] 0.069 68.9 2.42 0.7 1.7 3.4

9 [2.74m] 0.031 30.7 1.08 0.3 0.8 1.5

45o
3 [0.91m] 0.307 307 10.76 3.1 7.7 15.4

6 [1.82m] 0.073 73.1 2.56 0.7 1.8 3.7

9 [2.74m] 0.033 32.8 1.15 0.3 0.8 1.6

90o
3 [0.91m] 0.236 236.3 8.29 2.4 5.9 11.8

6 [1.82m] 0.057 57.4 2.01 0.6 1.4 2.9

9 [2.74m] 0.026 26 0.91 0.3 0.7 1.3

135o
3 [0.91m] 0.054 54.1 1.90 0.5 1.4 2.7

6 [1.82m] 0.016 15.7 0.55 0.2 0.4 0.8

9 [2.74m] 0.008 7.5 0.26 0.1 0.2 0.4

180o
3 [0.91m] 0.053 52.7 1.85 0.5 1.3 2.6

6 [1.82m] 0.014 14.4 0.50 0.1 0.4 0.7

9 [2.74m] 0.007 6.8 0.24 0.1 0.2 0.3

225o
3 [0.91m] 0.051 51.3 1.80 0.5 1.3 2.6

6 [1.82m] 0.014 13.7 0.48 0.2 0.3 0.7

9 [2.74m] 0.008 8.2 0.29 0.1 0.2 0.4

270o
3 [0.91m] 0.216 215.6 7.56 2.2 5.4 10.8

6 [1.82m] 0.054 54.2 1.90 0.5 1.4 2.7

9 [2.74m] 0.023 23.3 0.82 0.2 0.6 1.2

315o
3 [0.91m] 0.264 264.2 9.26 2.6 6.6 13.2

6 [1.82m] 0.065 65 2.28 0.7 1.6 3.3

9 [2.74m] 0.030 30.1 1.06 0.3 0.8 1.5
3 Feet above 0.043 42.5 1.49 0.4 1.1 2.1

3 Feet above + 3 Outward 0.103 103.3 3.62 1.0 2.6 5.2
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Radiation Scatter Field for Half Beam - 8.9 Second Scan
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Scatter Measurements for 23 Second Scans
23.0 second scan using pulsed X-ray: 619 frames, 19 ms pulse width at 5 mA. 
Based on this, the estimated workload is:

10 scans per week yielding a workload of 9.6 mA-min/week
25 scans per week yielding a workload of 23.8 mA-min/week
50 scans per week yielding a workload of 55.6 mA-min/week

Standard (full-beam) Diameter 8.5 - Height 8.5 cm
NOTE: Selectable voxel sizes are 0.25, 0.2 and 0.125.

Location

Distance in 
Feet

[meter]
Exposure 

(mR)
Exposure 

(μR)
Exposure
μR/mAs

10
scans/wk 

mR/wk

25
scans/wk 

mR/wk

50
scans/wk 

mR/wk

0o
3 [0.91m] 0.69 689.1 12.08 6.9 17.2 34.5

6 [1.82m] 0.17 165.3 2.90 1.7 4.1 8.3

9 [2.74m] 0.08 76.5 1.34 0.8 1.9 3.8

45o
3 [0.91m] 0.70 699.1 12.26 7.0 17.5 35.0

6 [1.82m] 0.16 163.1 2.86 1.6 4.1 8.2

9 [2.74m] 0.08 75.3 1.32 0.8 1.9 3.8

90o
3 [0.91m] 0.50 502.6 8.81 5.0 12.6 25.1

6 [1.82m] 0.13 127.4 2.23 1.3 3.2 6.4

9 [2.74m] 0.06 58.9 1.03 0.6 1.5 2.9

135o
3 [0.91m] 0.11 108.4 1.90 1.1 2.7 5.4

6 [1.82m] 0.03 32.9 0.58 0.3 0.8 1.6

9 [2.74m] 0.02 16.4 0.29 0.2 0.4 0.8

180o
3 [0.91m] 0.10 100.0 1.75 1.0 2.5 5.0

6 [1.82m] 0.03 31.5 0.55 0.3 0.8 1.6

9 [2.74m] 0.01 13.6 0.24 0.1 0.3 0.7

225o
3 [0.91m] 0.10 103.0 1.81 1.0 2.6 5.1

6 [1.82m] 0.03 30.2 0.53 0.3 0.8 1.5

9 [2.74m] 0.02 16.4 0.29 0.2 0.4 0.8

270o
3 [0.91m] 0.52 516.2 9.05 5.2 12.9 25.8

6 [1.82m] 0.13 126.4 2.22 1.3 3.2 6.3

9 [2.74m] 0.06 59.1 1.04 0.6 1.5 3.0

315o
3 [0.91m] 0.64 639.0 11.20 6.4 16.0 32.0

6 [1.82m] 0.16 156.3 2.74 1.6 3.9 7.8

9 [2.74m] 0.07 72.7 1.27 0.7 1.8 3.6
3 Feet above 0.08 75.5 1.32 0.8 1.9 3.8

3 Feet above + 3 Outward 0.25 248.0 4.35 2.5 6.2 12.4
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Half Beam Diameter 14 - Height 8.5 cm Scan

NOTE: Selectable voxel sizes are 0.25 and 0.2.

Location

Distance in 
Feet

[meter]
Exposure 

(mR)
Exposure 

(μR)
Exposure
μR/mAs

10
scans/wk 

mR/wk

25
scans/wk 

mR/wk

50
scans/wk 

mR/wk

0o
3 [0.91m] 0.57 571.1 10.01 5.7 14.3 28.6

6 [1.82m] 0.14 138.0 2.42 1.4 3.4 6.9

9 [2.74m] 0.06 61.5 1.08 0.6 1.5 3.1

45o
3 [0.91m] 0.61 615.0 10.78 6.1 15.4 30.7

6 [1.82m] 0.15 146.4 2.57 1.5 3.7 7.3

9 [2.74m] 0.07 65.7 1.15 0.7 1.6 3.3

90o
3 [0.91m] 0.47 473.4 8.30 4.7 11.8 23.6

6 [1.82m] 0.11 115.0 2.02 1.1 2.9 5.7

9 [2.74m] 0.05 52.1 0.91 0.5 1.3 2.6

135o
3 [0.91m] 0.11 108.4 1.90 1.1 2.7 5.4

6 [1.82m] 0.03 31.5 0.55 0.3 0.8 1.6

9 [2.74m] 0.02 15.0 0.26 0.2 0.4 0.8

180o
3 [0.91m] 0.11 105.6 1.85 1.1 2.6 5.3

6 [1.82m] 0.03 28.8 0.51 0.3 0.7 1.4

9 [2.74m] 0.01 13.6 0.24 0.1 0.3 0.7

225o
3 [0.91m] 0.10 102.8 1.80 1.0 2.6 5.1

6 [1.82m] 0.03 27.4 0.48 0.3 0.7 1.4

9 [2.74m] 0.02 16.4 0.29 0.2 0.4 0.8

270o
3 [0.91m] 0.43 431.9 7.57 4.3 10.8 21.6

6 [1.82m] 0.11 108.6 1.90 1.1 2.7 5.4

9 [2.74m] 0.05 46.7 0.82 0.5 1.2 2.3

315o
3 [0.91m] 0.53 529.3 9.28 5.3 13.2 26.5

6 [1.82m] 0.13 130.2 2.28 1.3 3.3 6.5

9 [2.74m] 0.06 60.3 1.06 0.6 1.5 3.0
3 Feet above 0.09 85.1 1.49 0.9 2.1 4.3

3 Feet above + 3 Outward 0.21 206.9 3.63 2.1 5.2 10.3
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Scatter Measurements for PAN Scan

Scatter was measured from a PAN scan set at Large Exposure.

Location

Distance in 
Feet

[meter]
Exposure 

(mR)
Exposure 

(μR)

10
scans/wk 

mR/wk

25
scans/wk 

mR/wk

50
scans/wk 

mR/wk

0o
3 [0.91m] 0.143 143 1.4 3.6 7.2

6 [1.82m] 0.0396 39.6 0.4 1.0 2.0

9 [2.74m] 0.0184 18.4 0.2 0.5 0.9

45o
3 [0.91m] 0.1462 146.2 1.5 3.7 7.3

6 [1.82m] 0.0376 37.6 0.4 0.9 1.9

9 [2.74m] 0.0178 17.8 0.2 0.4 0.9

90o
3 [0.91m] 0.0875 87.5 0.9 2.2 4.4

6 [1.82m] 0.0219 21.9 0.2 0.5 1.1

9 [2.74m] 0.0096 9.6 0.1 0.2 0.5

135o
3 [0.91m] 0.0541 54.1 0.5 1.4 2.7

6 [1.82m] 0.0075 7.5 0.1 0.2 0.4

9 [2.74m] 0.0041 4.1 0.0 0.1 0.2

180o
3 [0.91m] 0.0253 25.3 0.3 0.6 1.3

6 [1.82m] 0.0082 8.2 0.1 0.2 0.4

9 [2.74m] 0.0041 4.1 0.0 0.1 0.2

225o
3 [0.91m] 0.0246 24.6 0.2 0.6 1.2

6 [1.82m] 0.0075 7.5 0.1 0.2 0.4

9 [2.74m] 0.0082 8.2 0.1 0.2 0.4

270o
3 [0.91m] 0.091 91 0.9 2.3 4.6

6 [1.82m] 0.0226 22.6 0.2 0.6 1.1

9 [2.74m] 0.0109 10.9 0.1 0.3 0.5

315o
3 [0.91m] 0.1348 134.8 1.3 3.4 6.7

6 [1.82m] 0.0363 36.3 0.4 0.9 1.8

9 [2.74m] 0.0165 16.5 0.2 0.4 0.8
3 Feet above 0.03 30.7 0.3 0.8 1.5

3 Feet above + 3 Outward 0.01 7 0.1 0.2 0.4
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Radiation Scatter Field in Panaramic Mode - Large Exposure
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Scan Times and Settings
PAN Scans (Continuous)

Large exposure, 94kV, 5mA, 20 seconds

Small exposure, 84kV, 5mA, 18.3 seconds

CT Scans (Intermittent)

360o Scans

• 0.25, 0.20, 0.125 voxel, 120kV, 5mA, 23.0 seconds

• 0.4 and 0.3 voxel, 120kV, 5mA, 8.9 seconds

Half Scans (half revolution)

• 0.25, 0.20, 0.125 voxel, 120kV, 5mA, 12.6 seconds

• 0.4 and 0.3 voxel, 120kV, 5mA, 4.8 seconds

Linearity of Radiation Output: <.025 COV

Voxel Size mAs
Acquisition

Time

0.4 / 0.3 28.52 8.9 sec

0.25 / 0.2 / 0.125 57.06 23.0 sec

0.4 / 0.3 Half Scan 15.55 4.8 sec

0.25 / 0.2 / 0.125 Half Scan 31.20 12.6 sec

Voxel mm kV mA Scan 
Times

# of
Frames

360o Scans 
0.2 0.25 120 5 23.0 600

0.3 0.4 120 5 8.9 300

Half Scans
0.2 0.25 120 5 12.6 320

0.3 0.4 120 5 4.8 160

iPAN Large 94 5 20 1200

iPAN Small 84 5 18.3 1100
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Dose and Imaging Performance Information

The Computer Tomography Dose Index (CTDI) was measured 
using a 10cm, 3cc, pencil ionization chamber  from Radcal 
Corporation (10X9-3CT) in conjunction with a Radcal Corporation 
16cm diameter cylindrical CT head phantom (20CT6). This 
phantom has one hole at the center and four more at 90° intervals, 
1cm inside the outer circumference. The procedure used was as 
follows:

• The phantom was positioned with its axis perpendicular to 
the tomographic plane at the center of rotation, and its 
height adjusted such that its middle was at the same height 
as the horizontal laser line.

• The pencil ionization chamber was inserted into one of the 
holes and the other four were filled with acrylic rods.

• The phantom was scanned using one of the standard 
protocols and the exposure E recorded.

• The CTDI100 at this location was calculated using the 
formula: 
 
CTDI100 = E . f. L / T 
 
Where:  
E is the exposure in mR 
f is the factor to convert Roentgens to absorbed dose (rad). 
A value of 0.87 for the conversion in air was used. 
 
L is the active length of the chamber, 10cm 
T is the verical dimension of the beam.

• The derived quantity CDTIw (weighted) was calculated as 
follows: 
 
CTDIw = 1/3.CTDIcenter +2/3.mean(CTDIperiphery)

• The CTDI in free air was also measured, i.e. without the 
phantom in place, at the same location as the central hole 
occupied: i.e. the CTDI Free-air

The CTDIw and the CTDI Free-air were measured for the CT 
scanning modes available and the results are in the table below.
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Dose Profile

The dose profile was measured using ThermoLuminescent 
Dosimeters (TLD) placed at 2cm intervals vertically in the central 
column of the acrylic head phantom used for CTDI measurements, 
starting at the bottom position. The TLD chips were 3mm x 3mm x 
1mm thick in size and purchased from Global Dosimetry, Irvine, 
California.  2cm acrylic plugs were placed between the TLDs to 
space the TLDs and fill the space. The profile was measured for both 
Landscape (D 8.5 - H 8.5) and Half-Beam (D 14 - H 8.5) scans for 
standard scans of 8.9s. The TLDs were measured and the doses in 
mrem were converted to µSv. The results are presented in the figure 
and table below.

Scan Mode and Beam Size CTDIw mGy
CTDIFree air 

mGy

EDS 14 x 8.5 cm 4.72 10.10

14 x 6 cm (maxilla) 6.38 9.76

14 x 6 cm (mandible) 6.35 9.88

Landscape 8.5 x 8.5 cm 5.58 14.01

8.5 x 6 cm (maxilla) 7.56 13.20

8.5 x 6 cm (mandible) 7.51 13.20
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Dose/Scan µSv

Position  
cm Landscape Half-Beam

1 0.70 0.61

3 2.04 1.78

5 2.37 2.60

7 3.52 2.88

9 3.46 2.65

11 2.99 2.06

13 1.39 1.06

Vertical Dose Profile for Standard 8.9s Scans

Half-Beam

Position cm

D
os

e/
Sc

an
 µ

Sv

Landscape
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Sensitivity Profile

A 40 µm diameter Tungsten wire was scanned using the standard 
Dia. 8.5 - H 8.5 protocol with 0.2mm voxel resolution. The wire was 
held vertically at the system isocenter..

The Hounsfield units of the reconstructed image of the wire was 
measured at several slice positions with 0.2mm width and the 
resulting profile was compared against a Gaussian curve.  For each 
location, the width of the wire as measured by the standard deviation 
of the Gaussian curve was converted to a Full-Width Half-
Maximum (FWHM) value using the conversion factor of 2.3548 and 
was plotted and determined to be a measure of the sensitivity of the 
system.
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Drywall Attenuation
The attenuation due to typical drywall found in offices was 
measured. A simulated wall was constructed from two sheets of 5/8-
inch thick gypsum wallboard, spaced 4 inches apart, mounted on a 
wood frame. The wall was placed between a scatter source (a head 
phantom) and a Radcal Model 9010 Radiation monitor with 10X5 - 
180 dosimeter chamber. The system was operated in a regular 
scanning mode, and the radiation was measured with and without the 
drywall. The results are below:

Therefore, the effect of a typical drywall or wallboard is to reduce 
the X-ray radiation by about 40%. Please note that there may be 
differences depending on the wall construction and composition, 
and that this is an approximate guide only.

Measured Radiation mR

Distance from 
Head

3 ft
(0.91m)

6 ft
(1.82m)

9 ft
(2.74m)

No Drywall 344.0 82.5 38.2

With Drywall 204.5 49.8 23.2

Transmission 59% 60% 61%

Attenuation 41% 40% 39%

Sensitivity Profile

Position Z-Axis mm

Si
gm

a 
W

id
th

 o
f P

ro
fil

e 
m

m
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Recommended Operating Requirements

Local agencies or government bodies or international standards may 
dictate requirements for installation of the system in order to protect 
personnel and the public from exposure from the radiological output 
of the device. Consult your local agencies, government bodies, or 
international standards for actual requirements which apply.

It is recommended that a qualified Physicist or Radiologist 
determine where appropriate, the applicable lead shielding to be 
installed in the area around the system equipment. Below are some 
other common requirements that may apply to your location: 

• The Computer Workstation and X-ray Operator should be 
located behind a properly shielded permanent barrier. A 
viewing window (or alternative method such as a mounted 
mirror) should be present to enable the X-ray Operator to 
view the Patient and operate the computer while the 
exposure is present.

• Operators should consider the use of a lead apron to protect 
the anatomical areas of the medical personnel working in 
the areas exposed to radiation.

• The Operator Control Box and Acquisition Computer shall 
be located within 1 meter [3.28 ft] from door. If not, an 
interlocked door may be required.

• A room door may be required.

• Radiation warning signs may be required next to the 
entrance to the room.

• A Warning light may be required by the entrance to the 
room.

• A shielding plan should be performed where the system is 
being installed. Some local agencies or government bodies 
require that a shielding plan be conducted by a qualified 
Physicist or Radiologist and a copy of the shielding plan 
be submitted and approved prior to installation of the 
system.

• An area radiation survey by a qualified physicist or 
Radiologist may then be required within 30 days of initial 
clinical use of the system. This survey may be required to be 
submitted to the local agency or government body.
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• An annual radiation survey may be typically required. This 
survey is typically required to be submitted to the local 
agency or government body.

• A phantom or patients may be used for system training. 
Employees of the facility may not be used for this training.

• The system shall be registered with the local agency or 
government body.

X-ray Tube Assembly

Imaging Sciences International utilizes the SXR 130-15-0.5 X-ray 
Tube from Superior X-Ray Tube Company to manufacture our X-
ray head assemblies.

Nominal X-Ray Tube Voltage 120 kV

Max. Tube Current 7 mA

X-Ray Tube Nominal Anode Input Power 65 W

X-Ray Tube Maximum Anode Heat Content
  (HU = Kvp x mA x Time in Seconds)

30,000 HU

X-Ray Tube Single Load Rating 120kV, 5mA

Max. X-Ray Tube Assembly Heat Content 120K HU

Max. Continuous Heat Dissipation of Tube Assy 65W

High Voltage Supply Requirements 120 VAC at 10 amps

Loading Factors Concerning Leakage Radiation:
   CT Scan = 120KV  5mA 12 mS x 618 or 309
   PAN Scan = 94KV 5mA

< = 25mR/hr @ 1m
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Operator Data

Available focal spot size (mm): 
0.5

Available target angle: 15°

Anode construction:

Vacuum cast copper with 
tungsten target

Cathode construction:

Vacuum tube nickel with 
tungsten filament 

Max. Tube operating voltage:

130 kVp Full wave rectified

Inherent filtration/Window 
material:

2.0 mm/Glass

Cooling Method:

High dielectric transformer oil

Conditioning of Tube Head:

Must be at or above 22oC  
before first scan.

No system parts are connected 
to a Protected Earth Terminal.

X-Ray Tube Voltage X-Ray Tube Current Normal Electrical Power

84 kV 5mA 420W

94 kV 5mA 470W

120 kV 5mA 600W

SXR-130-15-0.5
FOCAL SPOT

TO RECEPTOR
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.

X-Ray Power Supply Tube Head

35-0 Tube Head

6 Pin Red
Connector

3 Pin Orange
Connector

1535 Tube Head Cable

1000-0 X-Ray Power Supply

J4 J10
120V 10A

1536 X-Ray Power
Supply Cable

J21

12
03

 S
ys

te
m

 B
oa

rd

Target Angle to Specific Reference Axis

28.1 in
(71.4 cm)

10o

10o

9.6 in
(24.4cm)

X-Ray Tube Head Markings
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SXR-130-15-0.5

70 kVp

130 kVp

90 kVp 100 kVp

EMISSION CHARACTERISTICS
(Full Wave Rectified, Single Phase, Bi-polar)

FI
LA

M
EN

T 
C

U
R

R
EN

T 
(A

M
P)

TUBE CURRENT (mA)

FILAMENT VOLT/AMPS CHARACTERISTICS:
60 Hz AC & DC

VO
LT

S

AMPS

ANODE HEATING/COOLING CURVE

A
N

O
D

E 
H

EA
T 

ST
O

R
A

G
E 

C
A

PA
C

IT
Y

(H
U

 X
 1

00
0)

TIME IN MINUTES
H.U. (Heat Units) = kVp (Kilovolts Peak)

Joules = .707 x H.U. 
x mA (eff) x Time (sec.)

ANODE HEAT STORAGE CAP
30,000 H.U.

MAX. ANODE HEATING & 

* OIL SUBMERGED ONLY

COOLING RATE
       165 HU PER SECOND
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HEATING

COOLING
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X-Ray Tube Head Heating and Cooling Chart

TIME (min.)

CONDITIONS FOR X-RAY TUBE HEAD HEATING AND COOLING TEST
MACHINE CYCLED IN PAN MODE: 1 SCAN EVERY 5 MINUTES
PAN MODE SETTINGS: 94KV  5MA  20SEC SCAN
AMBIENT TEMPERATURE: 22oC
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Appendix

 A iCATVision, iCATTransfer, 
& RSQM Installation

iCATVision

 iCATVision standalone is used to view images that have been 
acquired by an iCAT®  Acquisition Computer. iCATVision 
standalone can be installed on a computer that runs Window XP 
operating system. Other operating systems are not supported at this 
time. We are pleased to provide iCATVision free of charge to 
anyone with access to iCAT® scans with no limit on usage and the 
number of copies.
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Laptop Minimum Requirements
• Intel Processor M 1.5Ghz

• 1GB of RAM (2GB for peak performance)

• Windows XP Professional

• 40GB Hard Drive

• CDIDVD Drive

• Integrated Gigabit Ethernet 10/100/100 Network Connection

Workstation Minimum Requirements
• Processor 2Ghz

• 1GB of RAM (2GB for peak performance)

• Windows XP Professional

• Video Display capabilities of 1600 x 1200 resolution

• 18 or 19 inch Monitor (recomended)

• 40GB Hard Drive

• CDIDVD Drive

• Integrated Gigabit Ethernet 10/100/100 Network Connection

File Structure Setup

1. On the iCAT® Acquisition Computer, create an iCATVision 
folder under the C: drive.

2. Create a subfolder under iCATVision called iCATVision 
Watch

This is where the DICOM 3 data is exported. NOTE: Only 
DICOM files are placed here, NO FOLDERS.

File structure on iCAT® Acquisition Computer:

C:\

NOTE: It is not recommended to have the Watch folder located on a 
server because it would slow down the Network speed.

3. On the server or central storage location, create another folder 
named iCATVision.
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4. Under this iCAT Vision folder create a sub folder named 
iCATVision Root

File structure on server/central storage location:

C:\

If a server/central storage location is not available, then create 
the iCATVision Root directory on the iCAT® Acquisition 
Computer’s C: drive under the iCAT Vision Folder.

Create a new Folder

1. Open the folder where the new folder is to reside.

2. Right click and select New > Folder.

3. Type the name for the new folder.

Install iCATVision

1. Unzip the iCATVision.zip file to the iCAT Vision folder, it 
unzips to iCATVision.exe.

2. Double click the .exe file to execute the program.

A shortcut can be created for this program onto the desktop.

To unzip a file:

Right-click file and click Extract on the shortcut menu. 

To create a shortcut:

Right click file and select Send to > Desktop (create shortcut).
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iCATVision Setup

1. From iCAT Vision select Tools > Setup.

2. Under DICOM Database Root Folder, browse to the iCAT 
Vision\ iCAT Vision Root and click OK.

 (This may be on the C: drive or on a networked drive).

Setup is the same on all networked and non-networked 
computers or workstations.

3. A prompt to restart iCATVision software is displayed. Click 
OK.

NOTE: It is currently recommend that when using iCAT Data for 3rd 
party software, perform a separate DICOM export from iCAT®. The 
data will be interchangeable when third party systems start 
accepting compressed DICOM.
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iCATTransfer

NOTE: iCATTransfer is not required for iCAT® 17-19 Systems.

iCATVision is restricted to iCAT® DICOM scans and necessitates an 
“authentication” of DICOM data (Digital Imaging 
Communications). Authentication is performed by a program called 
“iCATTransfer” which is installed and executed on the iCAT® 
Acquisition Computer (computer capturing the scan) or another 
computer on the same network, in special cases. iCATTransfer 
authenticates and stores all newly exported DICOM data (from 
iCAT® software, to the Watch folder, and then to the Image Root 
folder.) The Image Root folder typically resides on a server or 
another central storage location.

If the computers are on the same network as the iCATTransfer, then 
there is direct access to the patient images. If running outside this 
network (e.g. a referring doctor’s office), then patient data may be 
transferred via a CD to the remote computer’s Image Root folder.

To reiterate, iCATVision only accepts iCAT® DICOM data that is 
authenticated by iCATTransfer. Images from the GXCB-500 
system do not require iCATTransfer.

Install iCATTransfer 

1. Unzip the iCATTransfer.zip file to the iCAT Vision folder, it 
unzips to iCATTransfer.exe.

2. Double click the .exe file to execute the program. 

A shortcut can be created for this program onto the desktop.

To unzip a file: Right-click the file and click Extract on the 
shortcut menu.
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iCATTransfer Passcode

When iCATTransfer is first launched, it opens to the iCATTransfer 
Validation Screen (below). Instructions are displayed to send an e-
mail to Imaging Sciences at keys@imagingsciences.com with your 
customer information and the authentication code shown on screen. 
We will return an e-mail with the Passcode to be entered into the 
iCATTransfer Validation Screen.

The program then opens, click accept to accept the License 
Agreement and then follow the instructions below.

iCATTransfer Setup

The program must be configured to “watch” for exported DICOM 
data from iCAT® in order to authenticate and transfer it to the image 
root directory. The program needs to be running in the background 
in order to detect the exportation of the DICOM Data. The 
iCATTransfer program can be placed into the StartUp Menu of the 
iCAT® Acquisition Computer (or server).

Putting iCATTransfer into the StartUp Menu

1. Right click the START button and select OPEN.

2. Double click Programs folder to open and then double click the 
StartUp folder to open.

3. Copy the iCATTransfer.exe file into this StartUp folder.
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Configure iCATTransfer

1. Launch iCATTransfer, the following window is displayed.

2. Under Folder to Watch, Browse to iCATVision\ iCATVision 
Watch folder and select. (This is most likely on the C: drive of 
the iCAT® Acquisition Computer).

3. Under Image Root Folder (Primary Destination), Browse to 
iCATVision Root folder and select. (This is most likely on a 
server/central storage location).

4. Click Start. This saves the preset Watch and Root destinations.

NOTE: If START is not clicked the transfer program will not work.

Remember, iCATTransfer must be running in order for the data to 
transfer (iCATTranfer can be minimized).

Accessing i-CAT® DICOM Data

iCATTransfer requires data to be exported from the iCAT® software 
in DICOM3 format.
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RSQM

The Remote Service Query/Retrieve Module (RSQM) enables CT 
or iPAN (DX) images to be requested and retrieved from a remote 
system, such as a Picture Archive and Communications System 
(PACS) using DICOM service protocols (C-FIND and C-MOVE). 
The retrieved images can then be viewed and manipulated in Vision.  

When the user issues a Query command in RSQM, all studies 
scanned on the remote system that meet the search criteria are 
returned. After a study is located, the user can retrieve the images for 
the study from the remote server. The remote server transfers the 
images to the user’s local computer, where they are stored. It is 
recommended that the storage location be set to the same root folder 
as the Vision viewer.

RSQM Installation and Setup

1. Place the RSQM.exe in the desired location. It is recommended 
to place it with the iCATVision.exe, but is not required.

RSQM

Vision

    Studies meeting 
criteria are returned

Study images are returned
  to user’s local computer

Remote
 Server

        “Query”
command issued

     “Retrieve”
command issued
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2. Double-click RSQM.exe. The DICOM Query/Retrieve Module 
is displayed.

3. Click Options.

4. Click Browse, and browse to the Image Root folder to select it 
as the default storage location on the local computer.

5. In DICOM section, enter Receiving Port, Receiving IP Address, 
and Local AE Title. This data must match the data entered on the 
Query/Retrieve (PACS) server side so that the two machines can 
communicate.

6. Click Save.
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Query and Retrieve Images

1. Double-click RSQM.exe. The DICOM Query/Retrieve Module 
is displayed.

2. Click Config.

a.  Enter Station name, IP Address, AE Title, and Port number 
for the DICOM node, such as a PACS, from where studies 
are to be queried and retrieved. This information may be 
provided by hospital IT or PACS personnel.

b. Click Save.

3. The Query Criteria default is to retrieve all studies scanned by 
the DICOM node selected above for the current day, or for a 
fixed period of time if the Fixed option is selected. Click Query 
to execute the default query.

To enter different query criteria to narrow or widen the search:

a. Enter desired search criteria in the Query Criteria area.
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b. Click Query. Studies meeting the criteria are returned from 
the remote server.

4. To retrieve images for a study:

a. Select a study from the list.

b. Click Retrieve. The images for the selected study are 
retrieved from the remote server and copied to the local 
computer in the folder that was specified during setup, 
usually ImageRoot.
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5. The study is 
displayed on the 
Study List in 
Vision. The 
patient’s name is 
also displayed in the 
new patient arrival 
box if Vision and 
RSQM are 
configured to point 
to the same Image 
Root folder.

The new patient 
arrival box lists all 
studies that have 
arrived in the Image 
Root folder since 
Vision has started 
for the current 
session. Studies can 
be copied to the 
Image Root folder  
when retrieved by 
RSQM, when 
transferred by 
iCATTransfer, or 
when manually 
copied in by the user.

6. If desired, click View Log to review the transactions that were 
completed or check for failures. To clear the log, click Clear 
Log.
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Status Messages

The following list defines the status messages that may be displayed 
on the DICOM Query/Retrieve Module screen.

Invalid retrival IP address. Please select new one 

The IP number selected in an option box is no longer valid. Open the 
options dialog and select a new one from the list.

Cannot use wildcard character with patient ID

A wildcard character is not allowed to be used for querying a patient 
ID.

Cannot use wildcard character with accession number

A wildcard character is not allowed to be used for querying an 
accession number.

Begin the retrieval process...

A study is about to be retrieved.

Unable to start retrieval. Please check network configuration 

Cannot initiate the DICOM receiver module. Please check that the 
network configuration was entered correctly and completely.

Cannot find network configuration for selected server

The selected server is no longer valid. Please reconfigure the remote 
station or choose new destination.

Connecting...

RSQM is trying to communicate with the remote station. 

Study list was queried successfully

Study was retrieved successfully

Requested operation was completed successfully.

Unable to send request to server. Please try again

RSQM is unable to request a list of studies from remote server.

Invalid command recieved from server. Please try again

Remote server does not return a valid respond to RSQM.

Query module failed communicating with server

RSQM does not understand the server's response.
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No data found against the request

Cannot find study that matches the selected criteria.

Retrieving selected study from server...

RSQM is retrieving selected study from remote server.

Unable to retrieve all files for the study

RSQM is unable to retrieve all files that are part of the selected 
study. User should try to retrieve the study again.

Communication with server failed. Study retrieval failed

RSQM was unable to communicate with the remote server.

Server doesn't support the retrieval service

The selected server does not support DICOM retrieval service.

Unable to connect to the server. Please check server configuration

RSQM was unable to connect to the remote server.
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Appendix

 B i-CATVision Release Notes

ID Known Issue
108 Institution Name field is not available when entering patient 

information or in the report. Related to work item 42. The “Institution 
Name” field shall default to empty and support 0-40 alphanumeric 
characters. 

Workaround: This field is only editable within the icatsystem.xml and 
this field is not being displayed in any screen, only read in the DCM 
viewer.

110 In Patient fields, the cursor focus is not set to the field which is to be 
corrected when wrong input is entered. The error message should 
display when the user moves to next field after entering wrong input in 
the previous field and the cursor focus should be set to the field which 
is to be corrected.

111 If a study is already opened before starting to burn a CD, the system 
asks to unload it. After the CD burning process is complete, the 
unloaded images appear and is loaded in memory. If the user tries to 
enter any of the preview views, nothing happens. Related to work item 
329.

112 Unloaded images persist on main Vision Screen (i.e. Preview Screen) 
after a study is unloaded.

113 On Implant screen, pressing Alt-F4 does not return to Preview Screen 
as with TMJ, Ceph, MPR screens.

118 There are two ways to have different patients with same ID. Related to 
work item 44.

135 When adding a cross section image to in implant report, then changing 
that image to Panoramic image, image doesn’t fit to the boundary even 
when resizing image container.

138 Back to Reports button remains active when running any report. Some 
function buttons in tool bar remain disabled.

139 Font settings change if zoom level of report is changed. 
140 When opening a saved report in 0.2 voxel patient study, an “end index” 

error occurs.
149 Workups created in older version of Vision will not work in 1.5.0.x 

release.
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150 Using the right-click shortcut does not show the Workup menu 
selection after a scan has been taken.

152 Workup gets lost when performing tilts in the Implant view.
153 System does not have UNDO capabilities. Related to work item 546. 

The Report feature does not support undo capabilities from one page to 
next, in order to capitalize on work already done instead of starting 
from scratch.

158 Wrong message displays during Geo Cal. Message “Preparing 
Geocalibrate preview acquisition” should display instead of “Moving 
panel to Landscape”.

163 Autodetection of arches for a 0.125 voxel scan sometimes locks system.
173 Saving the bottom middle image in the Ceph screen as a JPEG when 

the airway is turned on, xy plot (graphic) does not show in the file.
176 The user can not change the font size and color, including background 

color, in each text box in Reports. Related to work item 379.
177 In Reports, changing the size of Image (when Clip option is selected) 

displays the ruler at wrong position.
180 Preview scans crash when doing a Portrait preview followed by a 

Landscape preview.
197 Sometimes volume scans are only stored as Raw files, but not as CT, 

also after reconstruction, etc.
209 Insufficient memory and reconstruction error during acquisition.

Workaround: Use Retro Reconstruction to recover.
213 Incorrect scan length options for retro-reconstruction.
225 GXCB-500 Only: Collimation Calibration GUI in Calibrate.exe uses 

Portrait, Landscape terminology.
230 E-stop button needs to be released to stop multiple dialogs from 

displaying.

Workaround: User must obey the message “E-stop is pressed” dialog 
box and lift the E-Stop button when trying to enter Acquisition screen.

239 Stopping Geo Cal closes Calibration application.

Workaround: Restart Calibration application.
268 Time out error during a mode of panel calibration can cause calibration 

failure. 

Workaround: Restart Calibration application and rerun calibration 
again.

273 iPAN slide bar covering only 980 frames from 1276.

ID Known Issue
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288 Sometimes after burning a CD (single-uncompressed format) with a 
workup saved, when loading the CD, the workup name appears as NO 
NAME.

293 Performing a second Geo Cal after a successful first test causes 
problem. Shutter location not calculated correctly for customizations 
and defaults are not remembered for Landscape and Portrait Geo Cal. 

Workaround: Restart the Calibration application to resolve problem.
316 Filter Settings “Reset to Default” fails to reset default setting although 

right-click check indicates default settings.
318 When creating an Export CD, the Create CD button is active with no 

recordable media present.
331 GXCB-500 Only: The initialization process that homes the beam, 

platform and rotation are multi-threaded. The process of homing the 
machine when opening the application after some conditions may vary 
and does not indicate a limit switch condition.

333 3DVR won't load single file DICOM (error if trying to open, crash on 
transfer from Vision).

336 Patient birth date does not default to blank entry, but to current day’s 
date.

372 3DVR crashes when dragging the slider bar in the Range 4 section 
when using the Identify feature in Ax Views.

378 Ethernet cable disconnected (or connection lost for some reason) during 
scan causes various error messages to display depending on type of 
acquisition (Preview, Dry Run, Scan).

380 Level Up option under top menu has been changed. Related to FR-
0256.

Workaround: Use Screen menu option.
381 Unable to delete patient. When deleting a specific scan for a patient, 

Raw CT will not delete.
382 GXCB-500 Only: When user goes into the estimate nerve canal feature 

and confirms canal, if user changes the default matrix size from 5x2 to 
be either 3x1 or 7x3, errors are displayed.

389 GXCB-500 Only: In Preview screen: changing panoramic map view to 
MIP or RAD mode changes the maxilla/mandible arches.

391 GXCB-500 Only: Related to FR- 0328-0330, system does not indicate 
that data exceeds free space available and Create CD is not disabled.

392 Export CD: CD creation fails when selecting Multi-File DICOM.
394 Export CD: The data size estimate is identical for compressed and 

uncompressed. The “Total to Write” size is not accurate when the 
uncompressed option is selected.

ID Known Issue
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396 When removing data outside of scanfield, 5 to 6 mm of data is 
removed.

401 System fails to display warning when attempting to open dataset before 
it has finished loading. Related to FR-0342.

405 Retro recons do not show original data properly. When the 
retrospective screen is displayed and all the raw projections are loaded, 
user can not access the scan to do QF Toggle. No data is displayed and 
no previews (if taken).

Workaround: To get access to previews and scans without executing 
the reconstruction, the user needs to exit and re-enter to the 
reconstruction window.

407 GXCB-500 Only: Infrequent Contour line issues.
408 Contour line changes to red and green, instead of one color, on the 

Implant screen on the axial view. 
413 3DVR application: Error message displays after a second data set is 

opened when a Calculate VRT is performed.
416 Unable to enter date of birth prior to year 1900 and study is not 

displayed on the Patient List if the date of birth is exactly 1900.
420 When drawing distance measurements on the Implant cross sections, 

the lines are not visible right away.
422 When opening the Implant view, part of the axial image is outside the 

edge of the view.
431 GXCB-500 Only: When running Calibration application for the first 

time and trying to perform a Geo Cal, software crashes.
435 GXCB-500 Only: Canceling or timing out of auto collimation when it 

is performed for a second time causes collimators to stay at first 
position. 

Workaround: Calibration application should be closed and restarted to 
reinitialize the beam limiters.

459 GXCB-500 Only: Export DICOM. Output to Folder and CD burning 
for Single-Uncompressed file size is incorrectly displayed as 2KB for 
high resolution scans in some conditions.

478 GXCB-500 Only: On the Implant screen, the axial view has the feature 
to Rotate volume but there is no Reset Volume Rotation within screen.

480 In Reports, Image Attributes, the Overlays field label is cut off on the 
right side.

481 Reports: No print preview option. Relates to FR-0541.
482 Reports: Undo option is grayed out. Relates to FR-0546.
489 In Reports, missing landscape template containing Panoramic data 

only. Related to FR-0388.

ID Known Issue
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491 GXCB-500 Only. In Reports, variables in a template need to be added 
in separate boxes in order to be updated properly from case to case, 
when using the same template for different cases.

496 PAN: Method to lock bite stick vertically does not exist.
517 GXCB-500 Only. Unable to perform Retro Reconstruction when an 

external dataset has been placed manually into the image root folder.

Workaround: Delete QuickRawdir.bin from the system and restart 
VisionQ.

518 When different arches are selected, the level of the PAN image appears 
to change. Adjustments to Window/Level do not seem to make them 
equivalent either.

519 “QC Frames not found” message is confusing because situation is that 
QC Frames are not available for partial scans.

520 GXCB-500 Only: Midline with control points for maxilla arch does not 
appear when only maxilla contourline is checked.

523 Previewing continuously within the Calibration application causes the 
image to flicker between last preview and current one.

527 Chair alignment inaccurate in field.

Workaround: Align the placement of the chair using the calibration 
procedure and the Chair Alignment functionality in the Calibration 
application.

529 GXCB-500 Only: Nerve canal for half beam: marking the 4 foramina 
points does not have the options to calculate right, left or both canals.

532 Cannot export to DVD. Process prepares data, but attempt to send to 
DVD hangs.

533 GXCB-500 Only: Door Interlock. System collects empty frames when 
switch is opened after the dialog box to press Scan button is displayed 
when Previewing.

Workaround: Terminate application and restart. Do not open door 
during scan process.

534 GXCB-500 Only: When capturing a PAN scan, if e-stop button is 
pressed, incorrect dialog is displayed instructing to “Close door to 
continue scan message”. If Retry is selected on dialog, application stays 
in a loop.

Workaround: User needs to click on Cancel to clear exception and have 
proper message displayed related to e-stop button pressed.

540 When autodetecting arches, infrequently blue dots appear but not green 
line.

ID Known Issue
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542 When hitting a key while scrolling, blanked out cross section.

Workaround: Go back to Preview screen, then to Implant view to 
redisplay cross section.

543 GXCB-500 Only: New scan is not highlighted after a scan has been 
taken. The previous loaded CT is highlighted.

545 GXCB-500 Only: Default W/L (Level) setting for axial changes when 
switching between mandible and maxilla arch.

546 GXCB-500 Only: “Out of Memory Error” displayed occasionally when 
exporting an image within report template.

Workaround: Restart Vision application.
547 GXCB-500 Only: VisionQ application does not respond if an implant 

template is loaded using a lower matrix.
550 GXCB-500 Only: High Resolution Half Scans. Acquisition screen 

displays a black frame when adjusting W/L during the reconstruction 
process.

553 GXCB-500 Only: Preview Screen. Coronal view changes from RAD to 
MIP if user enters Ceph Screen, and then returns to Preview screen.

572 When reloading a saved workup (after only the mandible arch is auto 
detected), the system crashes under some conditions.

573 CT dataset is burned to CD when an iPAN procedure was selected 
under some conditions. Also occurs when Output to Folder is selected.

574 CD Write: Create CD button is not grayed out with data selected and no 
CD loaded. Related to FR-0330.

577 GXCB-500 Only: Preview Screen. When making measurements in any 
image and switching into the other arch, the measurements disappear 
when returning to the previous map.

578 GXCB-500 Only: Preview Screen. Axial view RAD projection changes 
to MIP when moving the height of any arch.

580 When acquiring images at heights that are not the full height, the 
measured value of the displayed image is less than the requested height.

581 GXCB-500 Only: Implant screen: When making measurements in any 
cross-section in any arch, then switching into the other arch, the 
measurements are deleted.

582 GXCB-500 Only: TMJ screen. Right Condyle disappears when saving 
any cross-section as a jpeg, when ST is at maximum value and 
projection is changed.

Workaround: To recover image, user needs to adjust the vertical 
control, zoom, pan, or window/level, or change back the projection. 

ID Known Issue
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583 GXCB-500 Only: Volume center stays in the Back position for CT, 
instead of the last position it was set to, when going from iPAN to CT 
mode.

593 Patient List: If data and/or images are moved from one system to 
another and the patient ID collides with an existing patient, the new 
data and/or images will be included in the existing patient's Patient List 
entry. However, the patient information displayed in the Vision 
window and any reports generated will be correct since that information 
is taken directly from the DICOM fields in the files, not the Patient 
List. Finding the newly added patient under these circumstances can be 
difficult, since it will appear under the original patient's name.

595 17-19 Upgrade: iCATVision.exe located in C:\dataframes is not 
updated with new version.

600 GXCB-500 Only: 3D airway image should display the proper cursor to 
move image. Zoom, W/L and Pan do not apply.

604 Lossy compressed images are not intended to be used for HU 
measurements. Lossy compression is designed to use 12-bit clipping 
resulting in differences in HU measurements.

605 MF and BD display previous loaded CT values when a new scan has 
been taken.

Workaround: Change to the desired Display Format prior to performing 
the Nerve Canal estimation.

606 Report: An empty Report folder gets created in the path where an iPAN 
jpeg is saved.

611 Recon BACK_PRJ crash when using two monitors on ACQ.

Workaround: Do not use a second monitor on the VisionQ system.
615 Reports: Saved report contains stray characters and missing/misaligned 

text.
616 Recovery from crashed scan gets confused.

Workaround: XML LastSystemState must accurately reflect the actual 
system state.

618 Vertical lines displayed in cross-section view of Implant screen.
624 Some viewing parameters are not retained when exiting and re-entering 

sub-screens.
640 TMJ report does not retain sizing when reopened.
649 Receptor crashes with iPAN patient support during CT scan.

Workaround: Do not use the iPAN patient support fixture when 
performing CT scans.
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651 GXCB-500 Only: After nerve canal detection, when ST < = 1.0mm on, 
panoramic arch gets out of place when moving the diagonal control to 
move arch to see the canal.

Workaround: Adjust arch in main Preview window.
652 Vision Standalone: Export CD periodically does not display all images 

in Implant/TMJ/MPR/Ceph screens.
658 VisionQ crashes on CD initialization failure.

Workaround: Use good media. Bad CD will cause the error.
661 Incorrect display and crash using reports.

Workaround: Select 20 or fewer description / options when adding text 
to a report.

664 Nerve canal error with a missing link.
668 Interpolation / filtering is not applied automatically when using mouse 

to scroll through slices in MPR screen.
671 Report template is not saved properly; fixed text and captions need to 

be reentered each time.
675 GXCB-500 Only: DICOM export for iPAN images do not export an 

adjusted window/level zoom on the CD.
676 eXamVision shows “not enough memory” in Implant screen 3D view 

on loading 0.125 voxel data.
682 Nerve Canal question screen text appears when any pervious nerve 

canal has been done on the dataset.

Workaround: Select Yes to remove previous nerve canal detection.
685 Control panel X-ray ready light not in sync with popup window “Push 

scan button”.

Workaround: Wait for popup window prior to pressing scan button for 
X-ray ready light.

692 GXCB-500 Only: Half beam high resolution scan gives a run-time error 
during reconstruction process.

693 GXCB-500 Only: Preview image does not refresh after the E-stop / 
Door software has been activated during a CT scan.

696 GXCB-500 Only: Patient ID name starting with a dot (.xx) is not 
displayed under the patient.

697 Error waiting for all frames to be saved.

Workaround: Configure the AVG anti-virus software to run at a time of 
day when the scanner is not being used to acquire data. Remove 
firewall restriction for VisionQ, then run a new VisionQ session.

ID Known Issue



B-9
G990710    30 June 2008

698 Image representation (window/level) after eXamVision and VisionQ 
start is wrong.

699 MPR image range selection shows one and the same image in report.
700 Report/volume slice mapping not unambiguously possible, especially 

left/right determination.
701 Vision: Implant view - discrepancy between the blue lines, tick marks 

and actual slice locations.
702 Vision: Preview screen with no contour line selected can not save AP, 

lateral, or CC views as jpeg files.
703 Calibration: Chair alignment feature should work with the platform 

(panel) set only at home position.

Workaround: Move the platform (panel) all the way to the back (home) 
position prior to performing the chair calibration.

704 Error recovery in geo calibration.

Workaround: If rotation is stopped during a chair calibration, exit 
Calibration application and rerun.

706 Reports not populating all information.
707 Wrong information is displayed in reports.
710 PC crashed while detecting nerve canal.

Workaround: Do not install/upgrade/remove software while running 
any of the VisionQ or Calibration applications.

716 After a nerve canal crash, Vision cannot start again.

Workaround: Do not leave the Quick Start PDF manual open while 
using nerve canal detection.

730 Ortho Screen: W/L problem in upper left image.
737 Reports: Out of Memory exception on JPEG export.
747 Opening either half scan CT or raw application crashes in some 

conditions.
750 Error message “cannot initialize DLL” when burning CD causes some 

files to be saved under a different path instead of Rawdata if user does 
not restart application when encountering error.

751 Nerve canal: calculating nerve canal then adding (Edit Points) two 
consecutive points on the cross-section causes axial image to disappear.

753 Hounsfield values will not be correct for new 17-19 8x8 protocol 
released in both iCAT and 3DeXam. HU values will be too low 
(attributable to bilateral truncation effects).
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Assembly Report Form Sample

  Complete Address of Installation

G1-15-1-0
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Manufactured by:
Imaging Sciences International LLC
1910 North Penn Road
Hatfield, PA 19440 U.S.A.
Tel: 1-215-997-5666
Fax: 1-215-997-5665

Manufactured for:
Gendex Dental Systems
Des Plaines, IL 60018 U.S.A.
Customer Service: 1-888-275-5286
Fax: 1-847-550-1322
Technical Support: 1-888-275-5286
Fax: 1-847-718-0716
www.gendex.com

Authorized Representative
Kaltenbach & Voigt GmbH
Bismarckring 39
Biberach, Germany
D-88400
Tel.  +49 07351 / 56-0
Fax. +49 07351 / 56-1488
e-mail: info@kavo.de
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